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Hub Managers

The Managers' Guide is a user manual for managing the web content and functionality of a
HUB. It progresses step-by-step through various common tasks and familiarizes the manager
with the administrative back-end interface. Managers will learn how to accomplish tasks such
as: 

Install new modules/widgets/plugins/templates
Manage (add/edit/delete) site members
Manage site settings
Handle support tickets
And more ...
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Introduction

Overview

The Managers' Guide is a user manual for managing the web content and functionality of a
HUB. It progresses step-by-step through various common tasks and familiarizes the manager
with the administrative back-end interface. Managers will learn how to accomplish tasks such
as:

Manage (add/edit/delete) site members
Manage site settings
Handle support tickets
And more ...

How To Use The Guide

The guide is grouped by Subject, then Chapters within a subject, then Sections within
Chapters. 

                            2 / 209



HUB MANAGERS
 

Administrator Area

Logging In

The Administrator Interface ( or “back-end”) of the HUB is where you do most of the work to set
up, configure and maintain your website. As such it must be protected from access by casual
visitors and will request a valid username and password before access to the Administrator
Interface is granted.

 

Access the Administrator Interface of the HUB by entering a special URL into the address bar of
your web browser.  If the HUB is located at https://www.example.com then you will enter the
address https://www.example.com/administrator will be shown the Administrator Interface login.

 

Enter your username and password into the relevant fields.  Click the "Login" button. If you login
successfully, you will  see the Administrator control panel.

Logging Out

To log out of the Administrator Interface, locate the "Logout" link in the top-right corner of the
Administrator Interface and click on it.  Logging out will return you to the Administrator Interface
login screen.  If the "Logout" link is grayed out and nothing happens when you click on it, then
you are probably in a screen where you have a page locked for your exclusive use.  Please
close out of the page by clicking “Save and Close” or “Close” to release the page, then click on
the "Logout" link.
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Getting Started: Advanced Setup

Your Hub's Getting Started Page

Your hub should have a getting started page at <your hub url>/gettingstarted. Most of the items
addressed on this page are discussed in further detail below.

Editing "About You", "How to Contact", & "Terms of Use" Pages

1. First login to the administrative interface of your hub.
2. Once logged in, find Content in the main menu bar located toward the top of the page. 
3. Click on the Article Manager link.
4. You should now be presented with a list of all the content articles. There are a few methods to find the

specific entry you want to edit.  You can filter by state, category, author, etc. or search for the title of
the article page.  A third option would be to look through the list manually, if you really want.

5. Please find the About Us page as we will use that as an example.  Once found, click the article title to
edit it.

6. You now should be presented with a page where you can edit the text, title and other page
parameters similar to the image below.

7. When your edits are complete, click the Save & Close toolbar button to save your changes and return
you to the Article Manager screen.

8. Alternatively, you may click the Save toolbar button to save your article but leave it open for editing.

Facebook Authentication

Step 1: Setting Up Facebook 

1. Navigate to (https://developers.facebook.com).
2. Begin by logging into a Facebook account or creating a new Facebook account for your

Amazon Instance.
3. After successfully logging into Facebook, click the My Apps tab, then in the drop-down

select Register as a  developer.
4. Read through the Facebook polices and accept the policies by changing the answer

from No to Yes with the switch button, and then click Register.
5. Select the My Apps tab again and from the drop-down click Add a New App.
6. Select the platform of the new app by clicking the WWW or "Website" icon.
7. In the upper right corner of the page, select the Skip and Create App ID button.
8. Fill in the Display Name in the name field and select the category of the application
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depending on your field.
9. Fill in the rest of the New App ID information or leave it blank depending on your

preference, then click Create App ID.
10. On the application dashboard, copy the App ID and App Secret. In order to copy the App

Secret you will have to click Show in order to access the full secret code.

Step 2: Enabling Facebook

1. Navigate to your Amazon Instance, and access the backend of the hub.
2. Click the Extensions tab and then from the drop-down select Plug-in Manager.
3. Locate the Authentication-Facebook plug-in and open the plug-in by clicking the plug-

in name.
4. Inside the plug-in, change the status of the plug-in from Disabled to Enabled.
5. Insert the App ID and Consumer Secret into the corresponding fields and click Save &

Close.
6. The Facebook Authentication will be available for users to use in order to login into the

hub.

 

LinkedIn Authentication

Step 1: Setting Up LinkedIn

1. Navigate to (https://www.linkedin.com/secure/developer).
2. Begin by logging into a LinkedIn account or creating a new LinkedIn account for your Amazon

Instance.
3. After successfully logging into LinkedIn, under the list of applications click Add New Application.
4. Fill out the form to register a new application. 
5. Click Add Application once you have finished filling out all the required fields in the application form.
6. Once you receive a message stating, Your application was successfully created, copy the API key

and the Secret key. 

Step 2: Enabling LinkedIn

1. Log into your Amazon Instance and log into the administrative side of the Amazon Instance. 
2. Under the Extensions tab select from the drop-down Plug-in Manager.
3. Inside the Plug-in Manager, locate the Authentication-LinkedIn plug-in.
4. Select the title of the plug-in, then inside the plug-in fill in the API key and the Secret key.
5. Enable the plug-in by selecting from the Status drop-down, then click Save & Close to save the
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changes that were made.
6. The LinkedIn plug-in will be successfully enabled and available for users to use as another option to

login to your Amazon Instance.

Google Authentication

Step 1: Enable the Google+ API

1. Navigate to the Google Developers Console (https://console.developers.google.com/project) and log
into a Google Account or create a new Google account for you Amazon Instance.

2. Select a project or create a new one by clicking Create Project:

3. In the Project name field, type in a name for your project. 
1. Note: Use a single project to hold all platform instances of your app (Android, iOS,

web, etc.), each with a different Client ID.
1. Click on the new project name in the list to start editing the project.
2. Click the Create button and wait for the project to be created.
3. In the Project ID field, optionally type in a project ID for your project or use the one

that the console has created for you. This ID must be unique world-wide.

4. In the left sidebar, select the APIs item below "APIs & auth". A list of Google web services appears.

5. Find the Google+ API service and set its status to ON—notice that this action moves the service to the
top of the list. You can turn off the Google Cloud services.

6. In the sidebar under "APIs & auth", select Consent screen.
a. Choose an Email Address and specify a Product Name.

7. In the left sidebar, select the IDs item below "APIs & auth".

8. Click Create a new Client ID — a dialog box appears. 

9. In the Application type section of the dialog, select Web application.

10. In the Authorized JavaScript origins field, enter the origin for your app. You can enter multiple
origins to allow for your app to run on different protocols, domains, or subdomains. Wildcards are not
allowed. In the example below, the second URL could be a production URL.

11. Click the Create Client ID button.

12. Register the origins from which your app is allowed to access the Google APIs, as follows. An origin is
a unique combination of protocol, hostname, and port.

13. In the resulting Client ID for web application section, copy the Client ID and Client
secret that your app will need to use to access the APIs.

Step 2: Enable the Authentication-Google Plug-in

1. Once you have collected your Client ID and Client secret, log into your Amazon Instance and
navigate to the administrative side.

2. Select the Extensions tab and then from the drop down select the Plug-in Manager button.
3. Locate the Authentication-Google plug-in and select the plug-in's title.
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4. Inside the plug-in, locate the Status section and select Enable from the drop-down.
5. Fill in the Client ID and Client Secret into the appropriate fields. 
6. Save all the changes by clicking Save & Close.
7. Your Amazon Instance users will be able to log into your instance with Google authentication.

Google Analytics

Step 1: Set Up Google Analytics on Google

1. Navigate to (google.com/analytics) and select Access Google Analytics.
2. You will be required to login to a Google account, at this point consider creating a new account for you

Amazon Instance or use a previously created account.
3. Click Sign Up and begin filling in the required fields in the analytics form.
4. Select Get tracking ID and then read and accept the terms of Google Anayltics by clicking I accept. 
5. You will receive a tracking ID, make sure you copy just the ID.

Step 2: Enabling Google Analytics 

1. Navigate back to your Amazon Instance and log into the backend or administrative side.
2. Click on the Extensions tab and the and select from the drop-down the Module Manager.
3. On the Module Manager page click the New button and locate Google Analytics from the new

module list.
4. Open the new module by clicking on it's title then fill in the tracking ID, title, and the position of the

module to be in the footer (typically, this module should be in a position present on every page--for
HUBzero-built templates, that tends to be position "footer").

5. Click Save & Close and Google Analytics will be installed in your Amazon Instance. 

 

Google Drive

Step 1: Configuring Google Drive in Projects on aHub
1. Navigate to console.developers.google.com and login with your hub gmail account.
2. Click Create Project to create a new project for your hub.

a. Enter the Project Name. We suggest using your hub name.
b. Enter the Project ID.  The Project ID is a globally unique identifier that cannot be

renamed.  Use the ID given, or specify a new one in the field.
c. Click Create.

3. Once created, click the link to your project to open it.
4. From the Dashboard, click “Enable an API” to select services for the project. From this
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list, find and turn on Drive API and Drive SDK services by clicking Off next to each to
switch them to On.   Be sure to accept Terms of Service if asked.

5. Next, navigate to the left hand menu to find APIs & auth. Click Consent Screen to set
up the branding information. Fill in all required fields.

a. Choose the hub email account from the Choose your email dropdown.
b. In Product name, type Project Files to Google Drive Connector.
c. Click Save.

6. Next, click  Credentials under APIs & auth.
7. Click Create new Client ID.
8. On the Create Client ID screen, choose Web Application under Application Type.
9. In the Authorize Javascript orgins field, type your hub URL (i.e. https://yourhub.org)

10. In the Authorized Redirect URIS field,  type your hub URL and add /projects/auth (i.e.
https://www.yourhub.org/projects/auth).

11. Click Create Client ID.
12.  Under Client ID for web application, note the Client ID and Client Secret, as these will

be needed.
13. Under Public API Access, click Create New Key.
14. Choose Browser key from the Create a new key pop-up.
15. In the HTTP Referrers field, type in your hub name followed by/*. Example:

yourhub.org/*
16. Click Create.  Note the API Key: After this step, you will navigate back to the hub to

configure.

 

Step 2: Turning on Google Drive in Projects

1. Navigate to yourhub.org/administrator and log in.
2. Navigate to the Extensions menu, and click Plug-in Manager.
3. In the search, type Projects, and click Search.
4. In the results, find the Projects – Files plugin. Click the title to edit.
5. Scroll down until you see the Google Connection Enabled option. Choose yes from the

drop-down.
6. Fill in the Google Client ID, Client Secret, and API Key fields with the information from

your account.
7. Choose when to auto-sync.
8. If you would like to only make Google Drive available to certain projects, type the alias of

the project into the Connected Projects.
9. Click Save & Close.
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CKEditor

CKEditor is a HTML text editor designed to simplify web content creation. It’s a WYSIWYG
editor that brings common word processing features directly into the web pages being built.
After a Hub has been updated to R1.3.0 various settings need to be adjusted on the
administrator backend of the Hub to allow CKEditor for all users.

Step 1: Global Configuration

1. On the backend of the Amazon Instance, select the “Site” tab from the top menu.

2. Click on the “Global Configuration” from the drop-down to open up the global configuration

settings.

3. Under the “Site” tab navigate to “Site Settings” and then locate “Default Editor”.

4. Select “Editor-CKEditor” from the drop-down.

5. Click “Save & Close” to save the newly changed settings.

Step 2: HTML Format Handler Plug-in

1. On the backend of the Amazon Instance, select the “Extensions” tab from the top menu.

2. Click on the “Plug-in Manager” from the drop-down.

3. Enter “Content – HTML Format Handler” into the search box and click “Search”.

4. Click on the “Content – HTML Format Handler” title to open up the plug-in.

5. In “Details” change the status to “Enabled” and then click “Save & Close”.

ReCAPTCHA

Step 1: Set Up ReCAPTCHA on Google

1. Navigate to (https://www.google.com/recaptcha/intro/index.html) and select Get reCAPTCHA.

2. You will be required to login to a Google account, at this point consider creating a new account

for you Amazon Instance or use a previously created account.

3. Fill in the Label field and Domain field with the appropriate information. 

4. Copy the Site key and Secret key.
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Step 2: Enabling ReCAPTCHA 

1. Navigate to your Amazon Instance and log into the administrative side.

2. Select the Extensions tab and from the drop-down select Plug-in Manager.

3. Locate the CAPTCHA-ReCAPTCHA plug-in and click on the title.

4. Change the status of the plug-in from Disabled to Enabled, then fill in the Public key and the 

Secret key.

5. Save the changes by clicking Save & Close, then ReCAPTCHA will be activated on your

Amazon Instance.
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Frequently Asked Questions

Article Pages: How do you set parameters for articles and other content
items?

Many Article parameters, such as “Show Title”, “Show Author”, and so on, can be set form the
backend of the Hub. This can be done by logging in to the backend, navigating to the “Article
Manager: Articles” page (Content-> Article Manager), and then selecting the article you would
like to adjust the parameter for. By clicking the box beside the title of the article, and then
clicking the “Edit” button to open up the article for editing.

Typically, parameters at the individual article and menu item levels can be set to a specific value
or to a value of "Use Global". If the individual article's parameter is set, then that value controls
the setting. If this is set to "Use Global" then the menu item parameter is checked. 

Courses: How can I view the outline a student would see in a course?

If you wish to view and check any prerequisites that have been set as an instructor you have to
enroll in the course as a student. Currently the instructor’s view of the course outline and the
outline students see are not the same. An instructor or a manager of a course will be able to
view all of the content and see that it is published or unpublished. For students, the outline they
view depends on the prerequisites for the parts of the course and what is available to them
during the course.

The best way for an administrator of a course to view what a student can see, would be to
create a testing account and enroll as a student in the course.

Groups: How do you send a group message?

Group messaging allows you to send out a message as an email to all the group members. A
Group Manager is the only one with the permissions to send out messages from the group to all
group members. To send out group messages follow these steps:

1. Navigate to https://yourhub.org/groups and log into the Hub.
2. Navigate to the group page and click on the Members tab.
3. Click on the email icon to send a message to all of the group members.

a. To email only a specific group member, select the same icon next to the
individual’s name.

4. Compose the message by:
a. Selecting whom the message is for from the drop-down.
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b. Fill in the subject title.
c. Write up the message.

5. Click the Send button to send the message to the group.                    

 

 

Projects: How do you connect Google Drive in a Project?

Note: Managers and Collaborators of a Project can connect their Google Drives, but the creator of the Project

must connect their Google Drive account prior to others adding on their accounts to the project.

1. Navigate to https://yourhub.org/projects and log into the Hub.
2. Access the project that you wish to add your Google Drive to.
3. Inside of the project access the Files tab and locate the Connect button.
4. Click the Connect button and then click the second Connect button.
5. Then choose the account or login to your Google account.
6. You will be relocated to a new page where you will accept the project files to Google

Drive for various access levels. Click Accept to confirm the last step.
7. Then you will be relocated back to the project confirming your Google Drive connection

to the project.

Support: How do I add other attachment file extensions for tickets?

1. Navigate to https://yourhub.org/administrator and login to the as an administrative
user.

2. Click on the Components tab and then click on Support.
3. On the Support: Tickets page, click on the Options button.
4. Inside of Support Configuration click on the Files tab.
5. Under Extensions, add the new file extension that can be uploaded to a ticket.
6. Click Save & Close to save the changes and to exit out of the Support

Configuration pop-up.

Wishlist: How do I change the status of a wish?
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The status of a wish serves to indicate to the general site users whether the wish was
accepted/rejected for implementation and when to expect the proposed feature online. Once a
wish is submitted, an administrator of the Hub can change the status of the wish. To change the
status simply open up the wish and then click Change status which is located under the wish.
From the drop-down box select the new status of the wish:

Pending: The wish is pending a response.
Accepted: The wish had been accepted and is currently being worked on.
Rejected: The wish has been rejected due to other contributing factors that disallow the
ability to create the wish. Example: Practicality or User use case
Granted: The wish has come true and is now available to the Hub.

Once the status has been selected, click Change Status to save the new status and inform the
user who submitted the wish what stage their wish is in right now.
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Settings

Overview

Note: Most, if not all, of these settings can be set once and then left alone. Most HUBzero
installs will have these configurations set for optimal performance. It is not advisable to make
changes to the "System" or "Server" settings. 

The settings are saved in '/configuration.php'. To save your changes, either the FTP-layer must
be activated or the 'configuration.php' file made writable. 

Toolbar

At the top right you will see the toolbar. The functions are: 

Save
Save the modifications you made to the Global Configuration. You will be redirected to
the Control Panel

Apply
Save it, but stay in the same screen. If you have been working on a screen for a long
time and don't want to risk losing your work, pressing Apply saves your work and lets
you continue working. If, for example, you lost your Internet connection, your work will
be saved up this point.

Close
Return to the previous screen without saving your work. If you press Close while adding
a new item, this new item will not be created. If you were modifying an existing item, the
modifications will not be saved.

Help
Opens the Joomla! Help Screen.

Site Setting Groups
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Site Settings

Site Offline
This setting shows when the site is offline. Only Administrators will be able to see the
site when Site Offline is set to Yes. The default setting is No.

Offline Message
The message that will be displayed on the site when the site is offline.

Site Name
The name of the site.

Default WYSIWYG Editor
(WYSIWYG stands for What You See Is What You Get) The default editor to use when
creating articles.

List Length
The length of lists in the Control Panel for all Users. By default, this is set to 20.

Feed Length
The number of content items to be shown in the feed(s). By default, this is set to 10.

Metadata Settings

Global Site Meta Description
This is the description of the site which is indexed by search engine spiders.

Global Site Meta Keywords
These keywords describe the site and are the basis for improving the ability of search
engine spiders ability to index the site.

Show Title Meta Tag
It shows the Meta information of each article. This Meta information is used by search
engine spiders when indexing the site. Each article can have its own Meta Data
information (set under the Metadata Information pane when creating or editing an
article).

Show Author Meta Tag
It shows the Author Meta information for articles and is used by search engine spiders
when indexing the site.

SEO Settings

SEO stands for Search Engine Optimization.

Search Engine Friendly URLs
When set to Yes, URLs are rewritten to be more friendly for search engine spiders. For
example, the URL: www.example.com/index.php?option=com_content&view=etc...,
would turn into: www.example.com/alias. Most of the items created in Joomla! have an
Alias box where a search engine friendly URL can be inserted. The default setting is No.

Use Apache mod_rewrite
When set to Yes, Joomla! will use the mod_rewrite settings of Apache when creating
search engine friendly URLs. Please note: it is advised that you do not modify any 
.htaccess file without an understanding of how it works. You must use the .htaccess
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file provided with Joomla! in order to use this setting. To use this file, rename the 
htaccess.txt file (found in the root directory) to .htaccess. By default, this setting is set
to No.

Add suffix to URLs
When set to Yes, Joomla! will add .html to the end of the URLs. The default setting is 
No.

System Setting Groups

 

System Settings

Secret Word
This is generated when Joomla! is first installed and is not changeable. It is used
internally by Joomla! for security purposes.

Path to Log folder
The path where the logs should be stored. The Joomla! installer should automatically fill
in this folder.

Enable Web Services
This feature enables Joomla! to make RPC (Remote Procedure Calls) using HTTP as
the transport medium and XML as the encoding language. This function should remain
on to ensure that many third party extensions works. The default setting Yes.

Help Server
The place Joomla! looks for help information when you click the Help button (visible in
many screens and options of the administration panel). By default, it uses Joomla!'s
main help site.
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User Settings

Allow User Registration
This determines whether users can register on the site. The default setting is Yes.

New User Registration Type
If Allow User Registration is set to Yes, this setting tells Joomla! what level of access
should be given to new users who register. The default setting is Registered.

New User Account Activation
This setting determines whether a new user will have to activate their account before
they can use it. If set to Yes, users will be sent an email containing a link to a web
address. The user must follow this link to activate his/her account. By default, this
setting is set to Yes.

Front-end User Parameters
When set to Show, users will be able to select their language, article editor, and help
site preferences from within their Details screen. The default setting is Show.

Media Settings

Legal Extensions (File Types)
These are the file types users are allowed to upload. By default, when Joomla! is
installed, basic image and document files are allowed.

Maximum Size (in bytes)
The maximum file size users are allowed to upload, in bytes. The default setting is 
10000000 (or 10mb).

Path to Media Folder
The path where non-image media files are located, including videos and document files.
The default is "<Joomla! home>/images". You can create a new folder to use with the
Media Manager and enter the path to that folder here. Warning: Do not delete or
rename the existing "<Joomla! home>/images" folder on your server. This folder and its
subfolders "images/banners", "images/M_images", "images/smiles", and
"images/stories" are used by Joomla!. Deleting or renaming these folders may cause
errors.

Path to Image Folder
The path where images are stored. The default is "<Joomla! home>/images/stories".
You can create a new folder to use with the Media Manager and enter the path to that
folder here. If you want to access this folder from the Media Manager, either use the
default value or make the new folder a sub-folder of the Media Manager folder. 
Warning: Do not delete or rename the existing "images/stories" folder on your server.
This folder is used by Joomla! and deleting or renaming it will cause errors.

Restrict Uploads
This feature restricts uploads by user type. The default setting is Yes.

Check MIME Types
This uses MIME Magic or Fileinfo to verify files. The default setting is Yes. By checking
the MIME information, you help ensure users don't upload malicious files to your site. If
invalid MIME type errors are received then change the setting to No.

Legal Image Extensions (File Types)
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This allows you to limit the types of images that can be uploaded. It operates by
checking the file image headers. By default, Joomla! only allows bmp,gif,jpg,png.

Ignored Extensions
This sets which extensions are ignored for MIME type checking and restricts uploads. By
default, no extensions are ignored.

Legal MIME Types
This sets the list of legal MIME types for uploads. By default, Joomla! automatically
includes some standard file types. It is recommended that you do not touch this setting
unless you know what you are doing.

Illegal MIME Types
This sets the list of illegal MIME types for uploads. By default, Joomla! automatically
blocks HTML MIME types. It is recommended that you do not touch this setting unless
you know what you are doing.

Enable Flash Uploader
This setting enables the integrated Flash Uploader which is used for example at the
Media Management. If enabled it is possible to upload several fieles at once. Default
setting is No. Tip: if enabled and the download does not work, disable the flash uploader
(can happen due incompatible flash settings by Adobe)

Debug Settings

Debug System
This will turn on the debugging system of Joomla!. When set to Yes, this tool will provide
diagnostic information, language translations, and SQL errors. If any such issues or
errors occur, they will be displayed at the bottom of each page, in both the front-end and
back-end.

Debug Language
This will turn on the debugging indicators (*...*) or (?...?) for the Joomla! Language files.
Debug Language will work without the Debug System tool set to on. But it will not
provide additional detailed references which would help in correcting any errors.

Cache Settings

Cache
This setting sets whether site caching is enabled or not. When enabled, it keeps a local
copy of the content on the server to speed up accessing and lessen stress on the
database. The default setting is No.

Cache Time
This setting sets the maximum length of time (in minutes) for a cache file to be stored
before it is refreshed. The default setting is 15 minutes.

Cache Handler
This setting sets how the cache operates. There is only one caching mechanism which
is file-based.

Session Settings
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Session Lifetime
This setting sets how long a session should last and how long a user can remain signed
in for (before logging them off for being inactive). The default setting is 15 minutes.

Session Handler
This setting sets how the session should be handled once a user connects and logs into
the site. The default setting is set to Database.

Server Setting Groups

 

Server Settings

Path to Temp-folder
The path where files are temporarily stored. This is filled in by default when Joomla! is
installed.

GZIP Page Compression
Compressing pages typically increases your site's speed. The default setting is No.

Error Reporting
This sets the appropriate level of reporting. The default setting is System Default.

Force SSL
This setting forces the site access for selected areas under SSL (https). Note: you must
have set already the server to use SSL. Options are:
None

SSL is not activated
Administrator Only

SSL is only valid for the backend.
Entire Site

SSL is valid for the whole site (front- & backend).
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Locale Settings

Time Zone
This tool sets the current date and time. The set time should be where the site's server
is located. The default setting is (UTC 00:00) Western Europe Time, London, Lisbon,
Casablanca.

FTP Settings

FTP stands for File Transfer Protocol. Most of these settings are set during the initial Joomla!
installation.

Enable FTP
This setting tells Joomla! to use it's built-in FTP function instead of the normal upload
process used by PHP.

FTP Host
The host server's URL connecting the FTP.

FTP Port
The port where the FTP is accessed. The default setting is 21.

FTP Username
The username that Joomla! will use when accessing the FTP server. Security
recommendation: create another FTP user account to access a folder where files will be
uploaded to.

FTP Password
The password that Joomla! will use when accessing the FTP server. Security
recommendation: create another FTP user account to access the folder where files will
be uploaded to.

FTP Root
The root directory where files should be uploaded to.

Database Settings

These settings are set during the initial setup of Joomla! It is advised to leave these settings the
way they are, unless you have a good understanding of how databases work.

Database Type
The type of databased to be used. The default setting is mysql, but this can be changed
during the initial setup of Joomla!.

Hostname
The hostname where the database is located. It is typically set to localhost for most
servers. It is possible for the hostname to be located on a different server all together.

Username
The username to access the database.

Database
The name of the database.

Database Prefix
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The prefix used before the actual table's name. This allows you to have multiple Joomla!
installations in the same database. The default setting is jos_, but this can be changed
during initial setup of Joomla!.

Mail Settings

The mail settings are set during the initial setup of Joomla!. These settings can be changed
whenever needed.

Mailer
This setting sets which mailer to use to deliver emails from the site. The default setting is
PHP Mail Function. This can be changed during the initial setup of Joomla!.
PHP Mail Function

This uses the mail function that is built into PHP.
Sendmail

This uses the Sendmail program, which is typically used when creating HTML
email forms.

SMTP Server
This uses the site's SMTP server.

Mail from
The email address used by Joomla! to send site email.

From Name
The name Joomla! will use when sending site emails. By default, Joomla! uses the site
name during the initial setup.

Sendmail Path
The path where the Sendmail program is located. This is typically filled in by Joomla!
during the initial setup. This path is only used if Mailer is set to Sendmail.

SMTP Authentication
If the SMTP server requires authentication to send mail, set this to Yes. Otherwise leave
it at No. This is only used if Mailer is set to Sendmail.

SMTP Username
The username to use for access to the SMTP host. This is only used if Mailer is set to 
Sendmail.

SMTP Password
The password to use for access to the SMTP host. This is only used if Mailer is set to 
Sendmail.

SMTP Host
The SMTP address to use when sending mail. This is only used if Mailer is set to 
Sendmail.
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Registration

Overview

HUBs allow for considerable customization of the registration form for new members. While one
HUB may present fields for filling in phone, website, and organization, another may take a more
minimal approach and require only a username, password, and email address. This is all
configurable.

Making Changes

1. First login to the administrative back-end.
2. Once logged in, find “Components” in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose “Register” from the available options.
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4. You should now be presented with a table of available user fields and their status for a
particular action. This controls what fields the user will see, must fill in (required) or can
fill in (optional) depending upon which action or state they are currently in. That is, you
can make the username field required for the registration page (“create” column) but
may not wish for your users to be able to edit this after creation (“read only” for the
“update” and “edit” columns).

Create column
What the user sees on the registration page

Proxy column
What columns an administrator sees or must fill in when creating an account by
proxy (i.e., for someone else)

Update column
What fields the user will see and/or must fill in if something has changed with
what information is required at registration. An example of this would be if the
“citizenship” field was, at one point, optional for registration but is now required.
Setting this field to “Required” for the “Update” column will now require logged-
in users to fill this information out.

Edit column
What fields the user will see and can edit for their user profile

Field Option Definitions:
Required = Must fill in
Optional = Can fill in
Hide = Not visible
Read only = Can view but cannot change
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5. Once you feel ready to save your changes, scroll back to the top of the page and click
“Save” (the icon that looks like a floppy disk) in the upper right portion of the page.

Changes take affect immediately.

Customizing Confirmation Email

All component layouts can be customized through overrides. Except for files that are provided in
the "Joomla!" distribution itself, this method for customization eliminate the need for designers
and developers to "hack" core files that could change when the site is updated to a new version.
Because they are contained within the template, they can be deployed to the Web site without
having to worry about changes being accidentally overwritten when your System Administrator
upgrades the site. Some emails sent by the system, such as registration confirmations, are
component layouts for just this reason of customization.

Quick Overview of Output Overrides

Layout overrides only work within the active template and are located under the /html/ directory
in the template. For example, the overrides for "corenil" are located under
/templates/corenil/html/.

It is important to understand that if you create overrides in one template, they will not be
available in other templates. For example, "rhuk_milkyway" has no component layout overrides
at all. When you use this template you are seeing the raw output from all components. When
you use the "Beez" template, almost every piece of component output is being controlled by the
layout overrides in the template. "corenil" is in between having overrides for some components
and only some views of those components.

The layout overrides must be placed in particular way. Using "Beez" as an example you will see
the following structure:

/templates
  /hubbasic
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    /html
      /com_register  (this directory matches the component directory n
ame)
        /emails        (this directory matches the view directory name
)
          confirm.php (this file matches the layout file name)

The structure for component overrides is quite simple:
/html/com_{ComponentName}/{ViewName}/{LayoutName}.php.

Customizing The Confirmation Email

To override the component layout for the registration confirmation email, copy:

/components/com_register/views/emails/tmpl/confirm.php  (the email sen
t if the user resends a confirmation)
/components/com_register/views/emails/tmpl/create.php  (the email sent
 upon registration)

to:

/templates/{YourTemplate}/html/com_register/emails/confirm.php
/templates/{YourTemplate}/html/com_register/emails/create.php

If the destination directories do not exist, create them. And then edit the contents of the file(s)
you just copied.

See Template Overrides for more information on customizing layouts and CSS.

Confirmation Return URL

By default, members who have just completed the confirmation process will be directed to a
"Thank you" page. It is possible, in HUBzero, to change the redirection URL to something else.
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Note: This only applies to the initial page the user sees upon confirmation of their email. To
customize the return URL members are redirected to upon login see Hub Configuration.

1. First login to the administrative back-end.
2. Once logged in, find “Components” in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose “Register” from the available options.

4. Once the page has loaded, select the “Parameters” button in the toolbar, found in the
upper right-hand portion of the screen. Click it.
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5. You should now be presented with a pop-up panel for various settings and
configurations of your site.

Look for the option titled "Confirmation Return URL". This will most likely be the second
item in the list.

6. Enter in the textbox the URL you wish members to be redirected to and then click
"Save".
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Components

Overview

Many components will have a set of parameters that can be configured. These parameters can
determine what functionality is presented to the user, be a default set of user options (what
profile fields are visible to site visitors by default, for instance), or settings needed for the
component to function properly. Accessing and adjusting these parameters is quick and easy. 

Note: Not all components will have configurable parameters. For those that do, the
configurations apply only to that component and should not affect any other components, site
settings, or module settings.

1. First login to the administrative back-end.
2. Once logged in, find “Components” in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose the component you wish configure from the available options. Here we've
chosen the "Hub" component.
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4. Once the page has loaded, select the “Parameters” button in the toolbar, found in the
upper right-hand portion of the screen. Click it.

5. You should now be presented with a pop-up panel for various settings and
configurations of your site.

6. Adjust the available parameters as needed and then click "Save". Changes take affect
immediately.
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Note: Very often a component will not function properly until component parameters have been
first inputted and saved. For instance, HUBzero tools will not work properly unless the
middleware configuration has first been defined in the tools component entry.
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Modules

Overview

Most modules will have a set of parameters that can be configured. These parameters can
determine what functionality is presented to the user, be a default set of user options, or
settings needed for the module to function properly (setting the URL to a feed for a feed reader
module, for instance). Accessing and adjusting these parameters is quick and easy. 

Note: Not all modules will have configurable parameters. For those that do, the configurations
apply only to that module instance. You may have multiple instances of a module with different
parameter configurations.

1. First login to the administrative back-end.

2. Once logged in, go to the "Module Manager." The Module Manager can be found by
selecting "Extensions" > "Module Manager" from the drop-down menu on the back-end
of your HUB installation.
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3. Choose the module you wish to configure from the available list.

4. Once the page has loaded, find the “Parameters” grouping, found on the right-hand
portion of the screen.

5. Adjust the available parameters as needed and then click "Save" (the icon that looks like
a star) in the upper right portion of the page. Changes take affect immediately.
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Plugins

Overview

Some plugins will have a set of parameters that can be configured. These parameters can
determine what functionality is presented to the user, be a default set of user options, or
settings needed for the plugin to function properly. Accessing and adjusting these parameters is
quick and easy. 

Note: Not all plugins will have configurable parameters. For those that do, the configurations
apply only to that plugin and should not affect component configuration, module configuration,
or site configuration.

1. First login to the administrative back-end.

2. Once logged in, go to the "Plugin Manager." The Plugin Manager can be found by
selecting "Extensions" > "Plugin Manager" from the drop-down menu on the back-end of
your HUB installation.
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3. Choose the plugin you wish configure from the available list.

4. Once the page has loaded, find the “Parameters” grouping, found on the right-hand
portion of the screen.

5. Adjust the available parameters as needed and then click "Save" (the icon that looks like
a floppy disk) in the upper right portion of the page. Changes take affect immediately.
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Users

Overview

By default casual visitors are allowed to register themselves on your website to gain access to
additional resources. For example, registered users might be allowed to submit resources or
simulation tools. Your Joomla! website implements a user registration policy which can be
adapted to suit your particular requirements so you decide what additional resources are made
available. You can disable user registration altogether if you prefer.

Users register themselves on your website using the "Register" link typically found in the upper
right-hand portion of every page (position may vary). Once registered, users will log in to your
website by entering their username and password using the login form found at
http://yourhub.org/login. There are also links on the form to manage users who forget their
usernames or passwords.

See Configuring Registration to learn more about changing registration settings.

                           38 / 209

/documentation/1.3.1/managers/configuring.registration


HUB MANAGERS
 

User Manager vs Members Component

User Manager

Joomla! comes with a User Manager accessed via the back-end from the "Site" drop-down of
the main menu. 

Members Component

HUBzero extends the standard Joomla! user profile with options for more demographic
information (race, sex, etc.) and various other key pieces of information needed for such things
as simulation tools. All this information can be accessed under "Members" in the "Components"
list found in the main menu of the back-end administration. 

When to use which

All user will have an entry in both the User Manager and the Members Component. Any
information edited with one, such as changing a user's name via the User Manager, will also be
automatically reflected in the other. Since the majority of fields in the User Manager are also
represented in the Members Component plus considerably more fields, it is recommended that
all user editing be done in the Members Component. The one exception concerns adjusting a
user's access level (regular user vs. administrator, etc.). This is still done only with the User
Manager. 

Managing Members: User Permissions

Users who work closely with the administration of the Hub need to be given access prior to
having these permissions. In order for users to gain these permissions, another Administrator of
the Hub can give other members the same permissions. To give a user Administrator access,
follow these steps:

1. Navigate to the administrative interface of the Hub, also known as the Backend
2. Once there, locate the Users tab and click it to open up a drop-down list
3. Click from the drop-down the User Manager button
4. On the "User Manager: Users" page, click on the name of the user that you wish to give

Administrator access to 
5. Inside the user's account information page, locate the "Assigned Access Groups" box

and click the check box of "Administrator" or the desired group field you want the user to
have permissions to

6. After this step, click on the button "Save & Close" to save the changes you made
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Creating by Proxy

Proxy-creating users

Note: This feature has moved from https://yourhub.org/register/proxycreate to the administrator
backend.

To create an account for another user:

1. In the backend, go to the Members component under the Users menu.
2. Click on the + button to add a new member.
3. Fill in the information about the new user.
4. Click Save & Close and if successful, you will be taken to the user's member backend

information page.
5. At this point, if the hub's setting (found in a plug-in called User - Joomla! under

Extensions>> Plug-in Manager) is set to send email out to newly-created users, the user
will be sent an email about the account and credentials (example below). If email
notification is off, the system will not send an email to the proxy-created user, and it will
be up to you to let them know about their credentials.

From: Your Hub <support@yourhub.org>
Date: Thu, Nov 13, 2014 at 5:01 PM
Subject: New User Details

Hello [NAME HERE],

You have been added as a User to [YOUR HUB] by an Administrator.

This email contains your username and password to log in to https://yo
urhub.org/

Username: [USERNAME HERE]
Password: [PASSWORD HERE]

Please do not respond to this message as it is automatically generated
 and is for information purposes only.
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Editing

Overview

Note: Editing of users is done through the HUBzero Members Manager component, not the
standard Joomla! User manager. Any changes made via the Members Manager will also be
reflected in the Joomla! User tables. Making changes with the Joomla! User Manager can lead
to data becoming out of sync.

1. First login to the administrative back-end.
2. Once logged in, find Components in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of all installed
components.

3. Choose Members from the available options.

4. You should now be presented with a list of all the members on your site. There are a
variety of methods to find the specific person you wish to edit: you can search by such
fields as name, email, and ID number. You may also scroll to the bottom of the page and
navigate your way through the entire list. Once found, click the person's name to edit
their information.

5. You may then edit their name, organization, employment status, etc.

6. Once you feel ready to save your changes, scroll back to the top of the page and click 
Save (the icon that looks like a floppy disk) in the upper right portion of the page.

Adjusting Access Level

Joomla! offers various levels of access and privileges for users. All new accounts, by default,
will be Registered Users, the access level with the least amount of privileges. Sometimes, you
will need to grant a (trusted) user administrative access so they can manage content and
portions of your hub. We strongly advise that administrative privileges be handed out rarely and
with caution.

To adjust a user's access level:

1. First login to the administrative back-end.

2. Once logged in, go to the User Manager. The User Manager can be found by selecting 
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Site > User Manager from the drop-down menu on the back-end of your HUB
installation.

3. Choose the user you wish to edit from the available list.

4. Once the page has loaded, find the Group option, found on the left-hand portion of the
screen under the User Details grouping.

The available access levels are as follows:

Registered User: Normal visitors who register at the site. Can view Menu Items
that have Access Level of Registered. Cannot edit or submit articles.
Author: Can submit new articles for approval in the front end only. A Publisher
or higher must approve. Cannot edit existing articles.
Editor: Can submit new articles or edit existing articles from the front end only. A
Publisher or higher must approve.
Publisher: Can submit, edit, or publish articles from the front end only.
Manager/Administrator/Super Administrator: Can do all of the above plus can
log into the back end with increasing rights.

5. Select the access level desired for the user and then click Save (the icon that looks like
a floppy disk) in the upper right portion of the page. Changes take affect immediately.
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Deleting

Overview

In order to delete a user from your database, log in to the administration panel and choose 
Site -> User Manager from the top menu. On the opening page, select the checkbox to the left
of the user's name you would like to remove and press the Delete button in the upper-right
corner.

                           43 / 209



HUB MANAGERS
 

Looking Up

Overview

There will be times you need to track down a user's information for whatever reason. This can
be a time-consuming task when presented with paging through potentially thousands of
accounts. Luckily, there are multiple ways you can search and narrow down results quickly. 

User Manager

Since information such as user ID, name, username, and email is kept consistent between the
User Manager and Members Component, you can use either one to search for a specific
account.

To search via the User Manager:

1. First login to the administrative back-end.

2. Once logged in, go to the User Manager. The User Manager can be found by selecting 
Site > User Manager from the drop-down menu on the back-end of your HUB
installation.

3. You will be presented with a list of all users registered on your site.

4. Above the list of users are a few options for filtering results.

On the left side is a search box. You can search for users by name, username, or email
address.

On the right side are a few select boxes that allow you to filter the users based on their
access level (editor, administrator, etc.)—here, it's called Group—or log status (logged
in/out).

5. Choose your method for filtering and the list of users will be narrowed down to match
those criteria. Once found, click the person's name to view/edit their information.

 

Note: If you need to find an account to access more information than name, username, and
email, it is recommended to search via the Members component.
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Members Component

From the Administrative Back-end

Since information such as user ID, name, username, and email is kept consistent between the
User Manager and Members Component, you can use either one to search for a specific
account. The Members Component, however, will allow access to more details about a user's
account. The extended demographic information provided by the Members Component, for
example, cannot be accessed via the User Manager.

To search via the Members Component:

1. First login to the administrative back-end.
2. Once logged in, find Components in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of all installed
components.

3. Choose Members from the available options.

4. You should now be presented with a list of all the members on your site. There are a
variety of methods to find the specific person you wish to edit: you can search by such
fields as name, email, and ID number.

5. On the left side, above the list of members, is a search field for filtering the list. You can
search by such fields as name, email, and ID number.

6. Choose your method for filtering and the list of users will be narrowed down to match
those criteria. Once found, click the person's name to view/edit their information.
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Default Settings

Private/Public Profiles

By default, new profiles are set to private. This means that only super administrators and the
member him/herself may see and access that profile's information. Private profiles do not
display in search results.

 

Public Profiles by Default

Member profiles may be set to public by default via the administrative Members component. To
do so, log in to the administrative back-end and find Members in the Components list of the
main menu. Once the Members manager page has loaded, locate the Parameters button in the
toolbar (top right, opposite of the Members heading). Click this. You should be presented with a
series of settings. Find Default Privacy and set to Public. All new accounts will now default to
public profiles.

Note: any accounts created before changing this setting will retain whatever configuration they
had. For instance, private profiles will remain private unless manually changed by the user.
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Members

Publishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be published. This would turn on the plugin

allowing users to access it from their profile page.
4. Click Publish and the plugin will be turned on.

Unpublishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be unpublished from the Hub. This would turn

off the plugin taking it off their profile page.
4. Click Unpublished and the plugin will be turned off.
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Password Rules

Creating a Password Rule

1. Log in to the backend of the Hub and access the Users tab and navigate to Members.
2. Locate the Password Rules tab in Members.
3. Click New to create a new password rule.
4. Choose the rule that you are going to add more regulations to.
5. Insert the descriptions that define the rule.
6. Insert the failure message if the user fails to meet the correct regulations.
7. Click Save & Close to save the

Deleting a Password Rule

1. Log in to the backend of the Hub and access the Users tab and navigate to Members.
2. Locate the Password Rules tab in Members.
3. Check the rule’s box and then click Delete to delete the rule.
4. The rule will automatically be removed from the Hub.

Editing a Password Rule

1. Log in to the backend of the Hub and access the Users tab and navigate to Members.
2. Locate the Password Rules tab in Members.
3. Check the rule’s box and then click Edit to begin editing the rule.
4. Click Save & Close to save the newly edited material.
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Plugins

Publishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be published. This would turn on the plugin

allowing users to access it from their profile page.
4. Click Publish and the plugin will be turned on.

Unpublishing a Member Plugin

1. Log in to the backend of the Hub and access the Users tab and then click Members.
2. On the Members main page, navigate to the Plugins tab.
3. Select the box beside the plugin that is to be unpublished from the Hub. This would turn

off the plugin taking it off their profile page.
4. Click Unpublished and the plugin will be turned off.
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Registration

Registration Fields

1. First log in to the administrative backend.
2. Once logged in, find Components in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose Registration from the available options.
4. You should now be presented with a table of available user fields and their status for a

particular action. This controls what fields the user will see, must fill in (required) or can
fill in (optional) depending upon which action or state they are currently in. That is, you
can make the username field required for the registration page (“create” column) but
may not wish for your users to be able to edit this after creation (“read only” for the
“update” and “edit” columns).

Create column: What the user sees on the registration page
Proxy column : What columns an administrator sees or must fill in when
creating an account by proxy (i.e., for someone else)
Update column: What fields the user will see and/or must fill in if something has
changed with what information is required at registration. An example of this
would be if the “citizenship” field was, at one point, optional for registration but is
now required. Setting this field to “Required” for the “Update” column will now
require logged-in users to fill this information out.
Edit column: What fields the user will see and can edit for their user profile
Field Option Definitions:  Required = Must fill in Optional = Can fill in Hide =
Not visible Read only = Can view but cannot change

5. Once you feel ready to save your changes, scroll back to the top of the page and click 
Save in the upper right portion of the page. Changes take affect immediately.

Customizing Confirmation Email

All component layouts can be customized through overrides. Except for files that are provided in
the Joomla! distribution itself, this method for customization eliminate the need for designers
and developers to "hack" core files that could change when the site is updated to a new version.
Because they are contained within the template, they can be deployed to the Web site without
having to worry about changes being accidentally
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Menus

Organizing Your Articles Using Menus

If you have a set of articles that you would like to group together, you can use Joomla! menus to
organize those articles in an easy-to-navigate fashion.

An example of this can be found on the default hub under the About (http://yourhub.org/about)
section (see also below).

1. To begin, find the URLs of the articles that you're interested in grouping together
1. Note: If you can't find, or don't know the URL, it comes from the article alias, the

section and the category (see below and view these documentation pages: 
Managing Articles, URLs).

2. With your article pages created, you'll need to make the menu structure
3. Navigate to Menus -> Menu Manager on the Joomla! backend and select New.
4. Give your new menu a unique name and title, then click Save 
5. Now you will see your new menu in the list.
6. Click the icon indicated below to start adding menu items to your new menu.

1. Note: It is important to realize, for clarity's sake, that there is a different between
"Menu" and "Menu Item". "Menu Item" represents an instance, or individual
menu link, while "Menu" represents the entity as a whole.

7. Now click the New button to add new menu items to your menu.
8. After clicking New, scroll down and select External Link.
9. Next, fill in the necessary information:

This is where you'll need to remember the URLs for the articles that you've
created (you'll add the URL to the "Link" field)
After creating this menu item, you'll be able to access this article page via the
URL for the article, or the Alias of the menu item

For example: according the screenshot below, both
http://yourhub.org/example/examplearticle1 & http://yourhub.org/article1
will work when trying to access this page via the browser (See URL
Redirects for more details). For the navigational menus to display
properly, though, you'll want to use the menu item alias when trying to
access your article page.

10. Click Save in the upper right-hand corner.
11. If you switch over to the front-end and navigate to your article page (via the menu item

URL), you should see a page similar to this one:
12. At this point, simply repeat the previous steps to create menu items for all of the articles

that you want to use together
13. The final step in this process is to assign the menu items that you've created to display

on the article pages.
14. To do this, navigate to Extensions -> Module Manager on the backend Joomla!

interface
15. Next, select New.
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16. Scroll down and select Menu from the list (either click on the link, or select the radio
button then scroll back up and click "Next").

Now fill in the correct information...make sure to:??

Give it a Title
Be sure Enabled is set to Yes
Give it the position Left
Set it to display on the correct pages

Under menu assignment, control click the menus items that we made in the
preceding steps. This is what tells Joomla! which pages to display our new menu
on.

Under Module Parameters, Menu Name should be the title of the menu that we
created earlier (example in this case)
Menu Style should be List?

17. When all of this has been done, click Save.

                           52 / 209



HUB MANAGERS
 

Content

Overview

Let's start with some definitions. An Article is some written information that you want to display
on your site.  It normally contains some text and can contain pictures and other types of content.

It is important to understand that the content of the site (article pages, modules, groups, etc.) is
totally separate from the visual formatting (template) of the site.  It is best to think of text entered
in the Administrator Interface as pure content and there is no need to style each individual
component. 
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Article Manager

Creating an Article

1. First login to the administrative Interface.
2. Once logged in, find Content in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as Article
Manager, Category Manager, and Media Manager.

3. Click on Article Manager.
4. Click the + sign to add a new article page. The New Article screen contains options for

categorizing and naming the article, editing content and selecting parameters.
5. Enter a title in the Title field. This is used when the article title is displayed.
6. Enter an alias in the Alias field. This is the alias that will appear in the URL. For

example, choosing hubzero as the alias will result in https://yourhub.org/hubzero.
7. Select a Category using the appropriate drop down menu.

If no category applies, choose Uncategorized.
8. Select the status of the article. If you would like to see it on the frontend immediately,

choose Published.
9. Select Access level.

Public: All hub visitors can access the article page.
Registered: Users must be registered and logged in to see the page.

10. In the Article Text field, enter the content of the article.
11. Click the Save and Close (star) toolbar button to save your changes and return you to

the Article Manager screen.
Alternatively, you may click the Save (check in a circle) toolbar button to save
your article but leave it open for editing.

12.  To find view your article on the frontend, navigate to yourhub.org/alias. If you chose a
category, this alias might be slightly different. See URL documentation under Content for
more information.

Editing an Article

1. First login to the administrative Interface.
2. Once logged in, find Content in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as Article
Manager,“ Category Manager, and Media Manager.

3. Click on the Article Manager link.
4. You should now be presented with a list of all the content articles. There are a few

methods to find the specific entry you want to edit.  You can filter by state, category,
author, etc. or search for the title of the article page.  A third option would be to look
through the list manually, if you really want.

5. Please find the About Us page as we will use that as an example.  Once found, click
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the article title to edit it.
6. You now should be presented with a page where you can edit the text, title and other

page parameters similar to the image below.
7. When your edits are complete, click the Save and Close (star) toolbar button to save

your changes and return you to the Article Manager screen.
8. Alternatively, you may click the Save (check in a circle) toolbar button to save your

article but leave it open for editing.

Deleting an Article

Moving to the Trash:

1. First login to the administrative Interface.
2. Once logged in, find Content in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as Article
Manager, Category Manager, and Media Manager.

3. Click on the Article Manager link.
4. Check the box next to the article you want to trash.
5. Then click Trash (trashcan) toolbar button. This will move the article to a trash bin so

that it can be retrieved later if needed.  It does not permanently delete the article.

 

To retrieve the trashed article, select the status filter of the article list to trashed.  This will show
all the articles with a status of trashed.  Click on the article’s title and choose the status that
you require – typically published.

 

Permanently Deleting:

1. If you want to make sure the Article is completely gone from the system (so no further
roll back is available), select the status filter of the article list to trashed.  This will show
all the articles with a status of trashed. 

2. Check the box next to the article you want to delete.
3. Click the Empty Trash (trashcan) toolbar button to remove the article permanently. 

Recovery is not possible after this action. 
Note: Articles in the Trash Manager are not the same as Archived Articles..

4. Check the box next to the article you want to unarchive.
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URLs

Understanding URLs for Sections, Categories, and Articles

When SEF URLs are being used, it can become tricky at times to discover which article a URL
path leads to. HUBs try to simplify some of this and make the association(s) of the path to
sections, categories, and articles a little more obvious. 

For the purposes of this explanation, we assume every section, category, and article has an
alias. In its simplest form, a URL will map to a path of
http://yourhub.org/{SectionAlias}/{CategoryAlias}/{ArticleAlias}. So, a URL of
http://yourhub.org/about/this/site would map to a section with an alias of "about", a category with
an alias of "this", and an article with an alias of "site". 

The resulting URL will start to collapse, or shorten, when sections, categories, and articles have
the same alias. For instance, if you have a section with alias "about", a category with an alias of
"this", and an article with an alias of "this"– notice it is the same as the category–the resulting
URL will be http://yourhub.org/about/this.  

If all three portions have the same alias, the http://yourhub.org/about/this/site shortens further. A
section alias of "about", category alias of "about" and article alias of "about" will simply produce
http://yourhub.org/about. 

Quick ReferenceSection Category Article URL
about this site http://yourhub.org/about

/this/site
about this this http://yourhub.org/about

/this
this this site http://yourhub.org/this/s

ite
about this about http://yourhub.org/about

/this/about
about about about http://yourhub.org/about

URL Redirects

If you find yourself wanting to redirect a certain URL to another page, then Joomla! has a
solution for you. And fortunately, the solution is as simple as creating a menu.

 

1. Navigate to Menus -> Menu Manager on the Joomla! backend
2. At this point, you can either create a new Menu or use an existing one. If you prefer the

former, click New in the upper right-hand corner, and give your new Menu a name such
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as Redirects. Alternatively, you could use the Default menu. The only thing to
remember is that you should use a menu that is not displayed on the site (e.g. the Main
Menu and About menus or displayed on the standard hub)

3. Irrelevant of which option you chose, select the icon in the Menu Item(s) row to add a
new Menu Item to your Menu to handle the redirect

4. Next, fill in the necessary fields
Add a Title
The Alias will be the address that a user would enter into the address bar of
their browser
The Link will be the page where the actual content exists

Example: According to the image below, if a user types
http://myhub.org/example, though that page does not exist, they will get
the content found at http://myhub.org/example/examplearticle1

5. Select Save.
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Answers

What is the Answers component?

Answers, or Questions and Answers in the front end, is a place to exchange knowledge
about things that are not found in the Knowledge Base. Ask a question that's relevant to your
community or help other users by providing an answer to their questions.

Note: You must be logged in on the backend in order to perform the tasks below.

 

Deleting an Answer

1. In the backend, navigate to Answers under the Components tab.
2. Go to the Answers tab and find the answer to be deleted.
3. Click on the check box for the answer to select it.
4. Click the Delete button symbolized by a trash can. The answer will be fully deleted.
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Submitting a Question

1. In the backend, navigate to Answers under the Components tab.
2. While on the Questions tab, click the New button symbolized by a plus sign.
3. Fill in the details of the question being submitted. Check the box for Anonymous to

remove your name from the question. Select the Notify of responses box to get
emailed about new responses to the question. Fill in the title and the description of the
question. Add tags to the question using the tag box.

4. Click Save & Close to save the new question to the hub.
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Billboards

Uploading an Image

1. To upload an image, open the Billboard you would like to edit.

2. Click Upload Image, located underneath the Background Image field.
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3. Click the Browse button located on the bottom of the Media Manager pop-up, and
locate  and select the picture you would like to upload.

4. Click Start Upload. You should then see your picture appear as an option.
5. Copy the file name and paste it into the Background Image field.
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Blogs

Backend Blog Manager Overview

Published - this icon means that the blog post can be viewed on the frontend of the
hub.
Unpublished - this icon means that the blog post cannot be viewed on the frontend of
the hub.
New - this button allows you to create a new blog post.
Edit - this button allows you to make changes to a blog post.
Delete - this button allows you to delete a blog post.

Creating a Blog Post

1. In the backend, navigate to Blog under the Components tab.
2. On the Blog Manager, click the New button to create a new blog post.
3. In the details of the blog post, select the scope. The scope is the location of the blog

either on the site, member, or group. If you're creating a group blog, select the group
that the blog should belong to from the drop-down.

4. Fill in at least the title and content for the blog post.
5. In the publishing options of the blog post, select the state of publishing from the drop-

down, the dates of when the blog is available, and if you would like to allow comments
on the post, check the box for Allow comments.

6. Click Save & Close.

Editing a Blog Post

1. In the backend, navigate to Blog under the Components tab.
2. Find the blog post you would like to edit and click on its title to open the post.
3. Edit the content of the post.
4. Click Save & Close to save the newly edited content.

Deleting a Blog Post

1. In the backend, navigate to Blog under the Components tab.
2. Find the blog post you would like to delete and click on the check box for that blog post.
3. Click on the Delete button symbolized by a trashcan and the blog post will be deleted.
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Publishing a Blog Post

1. In the backend, navigate to Blog under the Components tab.
2. On the Blog Manager, select the location of the blog post from the following tabs: site,

members, or groups.
3. Find the unpublished blog post you would like to publish and click on the checkbox next

to it to select it.
4. Click Publish and the selected blog post will be visible to users.

Unpublishing a Blog Post

1. In the backend, navigate to Blog under the Components tab.
2. On the Blog Manager, select the location of the blog post from the following tabs: site,

members, or groups.
3. Find the published blog post you would like to unpublish and click on the checkbox next

to it to select it.
4. Click Unpublish and the selected blog post will be no longer be viewable on the front-

end.
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Citations

Deleting a Citation

1. In the backend, navigate to Citations under the Components tab.
2. Find the citation to be deleted, and click on the check box for that citation.
3. Click on the Delete icon on the top of the page and the selected citation will be deleted.
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Collections

Plugins for Collecting

Plugins that can be used on the hub for collecting are: resource plugin, wiki page plugin, and
content plugin. These plugins can be turned on from the backend. Once the plugin is turned on,
a “Collect” button will appear on these components. Users can then collect resources, wiki
pages, or content (article pages). The collected material will be saved as a post with a link back
to the original content.

Plugin Names:

Content Plugin- “Content-Collect”
Wiki Page Plugin- “Wiki-Collect”
Resource Plugin- “Resources-Collect”

 

To turn on a Plugin:

1. Navigate to https://yourhub.org/administrator/ and login as an administrative user.
2. In the backend, under the Extensions tab, select Plug-in Manager.
3. Find the plugin, and then select the plugin by clicking the small check box.
4. Once the plugin has been selected, click Enable to enable the plugin.
5. The plugin will now be active on the hub and users will be able to use the plugin to

collect content for collections.

Editing Collection Items

(Note: You have to be logged into your hub in order to complete the following tasks)

1. Navigate to https://yourhub.org/administrator/.
2. Locate the Components tab and then select the Collections button located in the drop-

down.
3. On the Collection page, click the Items tab.
4. Locate the item and then check the box beside the title of the item.
5. Click the Edit button to edit the item.
6. Make the changes to the item and then click Save & Close to save the changes and

you will be navigated back to the Collection: Items page.
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Courses

Creating a Course

1. In the backend, navigate to Courses under the Components tab.
2. At the top of the Courses panel, click the + sign to add a new course.
3. Fill in the details of the course. (See below for field/option descriptions.)
4. Click on the drop-down section under Publishing, and determine if you want your

course to be a Draft or Published.
5. Click on Save to save the work that you have completed. You can only further edit your

course, such as add an image or managers, after you have saved the initial details.
6. Under the Managers area, add course administrators (Instructors, Managers, etc.).
7. Under the Image area, add a course image by dragging an image file into the upload

box.
8. Click Save & Close to save all the details of the course and to go back to the Courses

main page, where your course will now be listed.

 

Field/Option Descriptions

Course Alias: Your course alias. This will be part of the URL.
Course Title: The official name of your course. This name will be what users see when
browsing the hub.
Interests (tags): Helps categorize your course in search results. These tags can help
your course be discovered more effectually.
Blurb: A short description of the course.
Description: A longer description of the course. Here you can personalize what the goal
or concept is in further detail to your students.
Unpublished: The course is taken off the front end of the hub.
Published: The course can be found in the front end. Anyone can find the course
through searches.
Draft: The course is being drafted. The course is accessible only to course
administrators. This allows instructors and managers to build a course before it is
available to students.
Deleted: The course is deleted permanently. Once a course is deleted nothing can be
retrieved from the course after this action.

Creating Course Overview Pages (tabs)

1. In the backend, navigate to Courses under the Components tab.
2. Find your course in the list. Under the Pages column, click on the + sign to add a new
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page. 

Note: If there are already existing pages, you will see a number in place of the + sign.

3. Enter the title, URL, and content into the page details. In the published parameters
choose Yes to make the page active on the Course Overview. 

Note: Note: A new page must be saved before files can be uploaded.

4. Click Save & Close and your new page will appear in the course pages list in the
backend. On the frontend, your new page will show as another tab in the Course
Overview.

Opening up Enrollment into a Course

1. In the backend, navigate to Courses under the Components tab.
2. Locate the course and click the number of offerings for that course in the 

Offerings column.
3. Locate the offering and click the number of sections for that offering in the 

Sections column.
4. Click the section’s title.
5. Under the Details tab, locate Enrollment and select a response from the drop-down.

a. Open (anyone can join): Any user on the Hub can join this section of the
course.

b. Restricted (coupon code is required): Only users with a coupon code can gain
access to this section of the course.

c. Closed (no new enrollment): This section of the course is closed and cannot be
accessed by new students.

Editing Parameters in an Offering

1. In the backend, navigate to Courses under the Components tab.
2. Locate the course and click the number of offerings for that course in the 

Offerings column.
3. Locate the offering and click the title.
4. Locate the Parameters section and select the parameters for Progress Calculation.

Inherit from course defaults- means that all of the parameters preset on the
hub will be the same for this offering.

5. Click Save & Close to save the parameters for that offering.
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Editing Parameters in a Section

1. In the backend, navigate to Courses under the Components tab.
2. Locate the course and click the number of offerings for that course in the 

Offerings column.
3. Locate the offering and click the number pf sections for that offering in the 

Sections column.
4. Click the section's title.
5. Under the Details tab, locate the Parameters section and select the parameters for 

Progress Calculation.
Inherit from course defaults- means that all of the parameters preset on the
hub will be the same for this section.

6. Click Save & Close to save the parameters for that section.

 

Editing Discussion Parameters

1. In the backend, navigate to Courses under the Components tab.
2. Find the course and the click the number in the Offerings column.
3. Locate the offering and click the number of sections for that offering in the 

Sections column.
4. Click the title of the section that you would like to change the discussions settings in.
5. Under the Details tab, locate the Discussions Parameters area. In the drop-down,

choose All sections to show discussion threads across all sections in this offering, or
choose This section only to show discussion threads only by this specific section. 

6. Click Save & Close to save the changes to the parameters.

Deleting Assets

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down.

2. On the Courses page, locate the course.
3. After locating the course, under the Offerings column, select the number of offerings.
4. On the Courses: Offerings page, locate the offering.
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5. Locate the Units column and select the number of units.
6. Locate the Unit, then under the Asset Groups column select the number of under the

column.
7. Inside Asset Groups, check the box of the offering.
8. Click the Delete button to permanently remove the content and asset from the course.
9. A pop-up will appear asking Are you sure you want to remove these items?

10. Proceed to click Ok, and the items will be removed from the course.

Creating Certificates

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down.

2. On the Courses page, locate the course.
3. After locating the course, under the Cert. or certificate column click on the No

Certificate Set button.
4. On the Courses: Certificate: Create page, upload a PDF certificate file by choosing the

file from your files and then clicking Upload.
5. Once the file is uploaded, a preview will appear.

a. The preview is where you can place, drag, and resize various placeholders for
elements such as the user’s name, course name, etc. to be dynamically filled in
when a certificate is claimed.

6.  Click the Save & Close button in order to navigate back to the Courses page.

Deleting Certificates

Note: You must be logged into your hub in order to complete the following tasks

 

1. Click the “Components” tab and then select the “Courses” button located in the drop-
down.

2. On the Courses page, locate the course.
3. After locating the course, under the Cert. or certificate column click on the Certificate

Set button (?).
4. On the Courses: Certificate: Create page, click the Delete button.
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5. Click the Save & Close button in order to navigate back to the Courses page.
6. A pop-up will appear stating “Entry successfully removed” and you will be navigated

back to the Courses page.

Changing Deployment Time

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down.

2. On the Courses page, locate the course.
3. After locating the course, under the Offerings column, select the number of offerings.
4. On the Courses: Offerings page, locate the offering.
5. Locate the Sections column and select the number under the column.
6. Check the box of the section, and then click the Edit button.
7. In the Courses: Sections: Edit page, select the Dates/Times tab.
8. Locate the course asset and set a date and time for the content of the asset, which is

usually in the third tier inside the asset group.
a. Example: Exam> Exam 1> Exam1.

9. Set the date and time by clicking the From and To boxes to access the time pop-up.
10. Save the changes by clicking Save & Close and a pop-up will appear saying "Entry

successfully saved".

Display Number of Users Enrolled in a Course

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down.

2. On the Courses page, select the Options button in the top-right corner of the page.
3. Under the Defaults tab, locate the Show Enrollment Numbers option at the bottom of

the pop-up.
4. Select between Yes to show enrollment numbers or No to not show enrollment numbers

from the drop-down.
5. Click the Save & Close button to save the new setting and exit out of the pop-up.
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Extensions

Overview

Joomla! already is a rich featured content management system but if you're building a website
with Joomla! and you need extra features which aren't available in Joomla! by default, you can
easily extend it with extensions. There are five types of extensions for Joomla!: Components,
Modules, Plugins, Templates, and Languages. Each of these extensions handle specific
functionality.  

Components

The largest and most complex of the extension types, a component is in fact a separate
application. You can think of a component as something that has its own functionality, its own
database tables and its own presentation. So if you install a component, you add an application
to your website. Examples of components are a forum, a blog, a community system, a photo
gallery, etc. You could think of all of these as being a separate application. Everyone of these
would make perfectly sense as a stand-alone system. A component will be shown in the main
part of your website and only one component will be shown. A menu is then in fact nothing more
then a switch between different components.  

Modules

Modules are extensions which present certain pieces of information on your site. It's a way of
presenting information that is already present. This can add a new function to an application
which was already part of your website. Think about latest article modules, login module, a
menu, etc. Typically you'll have a number of modules on each web page. The difference
between a module and a component is not always very clear for everybody. A module doesn't
make sense as a standalone application, it will just present information or add a function to an
existing application. Take a newsletter for instance. A newsletter is a module. You can have a
website which is used as a newsletter only. That makes perfectly sense. Although a newsletter
module probably will have a subscription page integrated, you might want to add a subscription
module on a sidebar on every page of your website. You can put this subscribe module
anywhere on your site. 

Another commonly used module would be a search box you wish to be present throughout your
site. This is a small piece of re-usable HTML that can be placed anywhere you like and in
different locations on a template-by-template basis. This allows one site to have the module in
the top left of their template, for instance, and another site to have it in the right side-bar. 

Plugins
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Joomla! plugins serve a variety of purposes. As modules enhance the presentation of the final
output of the Web site, plugins enhance the data and can also provide additional, installable
functionality. Joomla! plugins enable you to execute code in response to certain events, either
Joomla! core events or custom events that are triggered from your own code. This is a powerful
way of extending the basic Joomla! functionality.  

Templates

A template is a series of files within the Joomla! CMS that control the presentation of the
content. The template is not a website; it's also not considered a complete website design. The
template is the basic foundation design for viewing your website. To produce the effect of a
"complete" website, the template works hand-in-hand with the content stored in the database.  

Languages

Probably the most basic extensions are languages. Languages can be packaged in two ways,
either as a core package or as an extension package. In essence, these files consist key/value
pairs, these pairs provide the translation of static text strings which are assigned within the
Joomla! source code. These language packs will affect both the front and administrator side.
Note: these language packs also include an XML meta file which describes the language and
font information to use for PDF content generation. 

Conclusion

If the difference between the three types of extensions is still not completely clear, then it is
advisable to go to the admin pages of your Joomla! installation and check the components
menu, the module manager and the plugin manager. Joomla! comes with a number of core
components, modules and plugins. By checking what they are doing, the difference between the
three types of building blocks should become clear. You can also check out the official Joomla!
extensions page. Browse through the extension categories and you will be amazed about the
extension possibilities you have for your site.
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Installing

Overview

See Installing Extensions in the Web Developer's Guide for details. 
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Modules Manager

Overview

The Module Manager is where you add and edit Joomla! Modules. In Joomla!, Modules are
used to display content and/or media around the main content.

The Module Manager can be found by selecting "Extensions" > "Module Manager" from the
drop-down menu on the back-end of your HUB installation.

 

Module Facts:

1. All Joomla! websites require at least 1 Menu Module
2. All Other Module Types are Optional. (Examples: News, Banner, Latest News, Polls)
3. Every Menu is accompanied by a menu module. (Example mod_mainmenu)
4. Multiple occurrences of similar module types.
5. Some Modules are linked to components. For example, each Menu Module is related to

one Menu component. To define a Menu in Joomla!, you need to create the Menu and
Menu Items using the Menus screens and then create the Module for the Menu using
this screen. Other Modules, such as Custom HTML and Breadcrumbs, do not depend
on any other content.

A HUBzero installation is accompanied with over 20 Joomla! default module types and
additional, HUBzero-specific modules.

Column Headers

 

Click on the column heading to sort the list by that column's value.

Number (#): An indexing number automatically assigned by Joomla! for ease of
reference.
Checkbox: Check this box to select one or more items. To select all items, check the
box in the column heading. After one or more boxes are checked, click a toolbar button
to take an action on the selected item or items. Many toolbar actions, such as Publish
and Unpublish, can work with multiple items. Others, such as Edit, only work on one
item at a time. If multiple items are checked and you press Edit, the first item will be
opened for editing.
Module Name: The name of the Module. You can click on the name to open the Module
for editing.

                           74 / 209



HUB MANAGERS
 

Enabled: A green tick or a red X showing whether the use of the component is
enabled/disabled. Click the icon to toggle the item between enabled and disabled.
Order: The order to display modules within a Position. If the list is sorted by this column,
you can change the display order of modules within a Position by selecting a Position in
the "Select Position" filter and then clicking the arrows or by entering the sequential
order and clicking 'Save Order'.
Access Level: Who has access to this item. You can change an item's Access Level by
clicking on the icon in the column. Current options are:

Special: Only users with author status or higher have access
Registered: Only registered users have access
Public: Everyone has access

Position: The position on the page where this module is displayed. Positions are
locations on the page where modules can be placed (for example, "left" or "right").
Positions are defined in the Template in use for the page. Positions can also be used to
insert a Module inside an Article using the syntax "{loadposition xxx}", where "xxx" is a
unique position for the module.
Pages: The Menu Items where this Module will be displayed. Options are "All" for all
Menu Items, "None" for no Menu Items, and "Varies" for selected Menu Items. A Module
will only display on Menu Items where it is selected.
Type: The system name of the Module. Joomla! installs 20 standard Modules. Many
Joomla! Extensions contribute additional Modules.
ID: The ID number. This is a unique identification number for this item assigned
automatically by Joomla!. It is used to identify the item internally, for example in internal
links. You can not change this number.
Display Number: The number of items to display on one page. If there are more items
than this number, you can use the page navigation buttons (Start, Prev, Next, End, and
page numbers) to navigate between pages. Note that if you have a large number of
items, it may be helpful to use the Filter options, located above the column headings, to
limit which items display (where applicable).

Toolbars

Primary Toolbar

Enable: To enable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the "Enabled" column.
Disable: To disable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the "Enabled" column.
Copy: To copy one or more Modules, select them using the Checkbox and press this
button. A new Module will be created for each selected Module. The new Module will
have the name "Copy of" plus the original Module name. Note that the new copies are
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initially disabled.
Delete: To delete one or more items, select them and click this button. The selected
items will be deleted. Note: only empty items can be deleted.
Edit: Select one item and click on this button to open it in edit mode. If you have more
than one item selected (where applicable), the first item will be opened. You can also
open an item for editing by clicking on its Title or Name.
New: To create a new instance of a Module, press this button. You will be taken to a
screen that lists all of the available Modules. See Module Manager - New/Edit for
information about adding Modules.
Help: Opens this Help Screen.

Site and Administrator Links: At the top left, above the Filter.

Site: Opens the Site tab. This is the default tab and allows you to manage the Modules
for the front end of the web site.
Administrator: This tab allows you to manage the Modules for the back end
administration of the web site. If you do not need to change the Joomla! administrator
menus, no modifications are required here.

List Filters

Filter by Partial Title

You can filter the list of items by typing part of the title or the ID number. Or, you can select a
combination of Category and Published State.

Filter: In the upper left corner just above the column headings is a Filter field and two
buttons, as shown below:

If you have a large number of items on the list, you can use this filter to find the
desired item(s) quickly. Enter either part of the title or an ID number and press
'Go' to display the matching items. You can enter in whole words or part of a
word. For example, "ooml" will match all titles with the word "Joomla!" in them.

 

Filter by Template, Position, Type and Published State

In the upper right area, above the column headings, are following drop-down list boxes as
shown below. The selections may be combined. Only items matching both selections will
display in the list.

Select Template: Select the Template from the drop-down list box of available
Templates. Only Templates that are enabled for this site will display.
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Select Position:Select a Position from the drop-down list box of available Positions.
Select Type: Select the Module Type from the drop-down list box of available Module
Types. Joomla! installs with 20 available Module Types. Additional ones may be
available if you have installed any Joomla! Extensions.
Select State: Use the drop-down list box to select the published state: Enabled or
Disabled.

Create/Edit Modules

When you create a new Module, you will select the Module Type. This will determine what type
of content this Module can display. If you edit an existing Module, the Module Type will already
be determined. Note: You cannot change the Module Type of an existing Module.

All Modules have two sections that are the same: Details and Menu Assignment. The
Parameters are different for each Module Type.

Module Type: This displays the system name of the module. No entry is allowed.

Title: The Title of the Module.
Show Title: Whether or not to show the Title of the Module.
Enabled: Whether or not the Module is enabled. If "No", the Module will not be shown
on the page.
Position: The Position on the page to show the Module. There are two types of
Positions you can use.

You can select a Position from the drop-down list box. The Positions in the list
box are those provided by your Template. You can see the available Positions
on the page by adding the letters "?tp=1" to the end of any front-end Joomla!
URL. For example, if your home page is "www.mysite.com", you can type the
URL "www.mysite.com?tp=1". The page will display with labeled rectangles
indicating each pre-defined Position for the current Template.
You can type in a Position that is different from the pre-defined positions (for
example, "myposition1"). This type of Position can be used to insert a Module
into an Article. If you enter the code "{loadposition xxx}" inside the text of an
Article, where "xxx" matches the Position of a Module, and if the Module is
assigned to the the Menu Selection where the Article is displayed (see Menu
Assignment below), then the Module will be displayed at that point in the Article.

Order: The Order that this Module will be displayed within the Position. If more than one
Module is displayed at the same position, this will determine the order of display. The
drop-down list box shows all Modules displaying at the current Position. Select the
Module that you want the current Module to follow.

You can also change the order of display in the Module Manager. The Module
Order is only important when two or more Modules are displaying at the same
Position and on the same Menu Selections.
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Access Level: Who has access to this item. Enter the desired level using the drop-
down list box. Current options are:

Public: Everyone has access
Registered: Only registered users have access
Special: Only users with author status or higher have access

ID: The ID number. This is a unique identification number for this item assigned
automatically by Joomla!. It is used to identify the item internally, for example in internal
links. You can not change this number.
Description: A description of what the Module does. No entry is allowed.

Menu Assignment

This is where you tell Joomla! which pages to show this Module on. This Module will show on
the page when this Menu Item is selected. If the Menu Item allows the user to navigate to sub-
pages, then this Module will also show on these sub-pages. For example, if the Menu item is a
Blog Layout, the Module will also show when the user clicks on a "Read more..." link, an Article
Link, or a Page Navigation link from that Blog Layout.

 

Menus: "All" means show the current Module on all Menu Items. "None" means don't
show the Module on any Menu Items. "Select Menu Item(s) from the List" allows you to
select which Menu Items to show the Module on.
Menu Selection: If "Select Menu Items(s) from the List" above is selected, select
individual Menu Items that will display the Module.

Use Ctrl+Click to select multiple Menu Items.
Use Shift+Click to select a range of Menu Items.
If you want to select most of the Menu Items, first click "All" above under Menus
and then click "Select Menu Items(s) from the List". All of the Menu Items will be
selected. Then use Ctrl+Click to deselect the Menu Items you don't want to
include.

Parameters: This will vary between modules.
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Templates Manager

Overview

The Template Manager is where you assign a default Template to your Joomla! web site. You
can also edit and preview Templates here.

In Joomla!, the visual layout of both the Front-end and Back-end of your site is controlled by the
Template. Templates are extensions that contain layout and style information that tells Joomla!
exactly how to draw each page of your site.

When you first install Joomla!, one Back-end Template and two Front-end templates are
included. Other Templates can be installed from third-party developers as Extensions.

If you want to use the same Template for all of the pages on your site, you just assign one
Template as the Default Template. You can also assign different Templates to different pages.

Select "Extensions" ? "Template Manager" from the drop-down menu in the back-end of your
Joomla! installation.

 

Column Headers

#: An indexing number automatically assigned by Joomla! for ease of reference.
Template Name: The name given to each Template by the Template author. Click the
Name to open the Template for editing. If you hover the mouse over the Template
Name, a small preview for the Template displays in a pop-up window. The Template
Name normally corresponds to the sub-directory name that contains the Template in the
<path-to-Joomla!>/templates/ directory. For example, the files for the "rhuk_milkyway"
Template are in the directory "<path-to-Joomla!>/templates/rhuk_milkyway".
Default: Indicator of Default Template.
Assigned: Shows whether this Template has been assigned to any specific menu
items. To assign a template to menu items, open the Template for editing.
Version: The version number of the Extension.
Date: The date this extension was released.
Author: The author of this extension.
Display #: The number of items to display on one page. If there are more items than
this number, you can use the page navigation buttons (Start, Prev, Next, End, and page
numbers) to navigate between pages. Note that if you have a large number of items, it
may be helpful to use the Filter options, located above the column headings, to limit
which items display (where applicable).
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Toolbars

Default: Select the Template that you want to be the default Template. Then click this
button. The default star symbol will show in the Default column, indicating that this is
now the default Template.
Edit: Select one item and click on this button to open it in edit mode. If you have more
than one item selected (where applicable), the first item will be opened. You can also
open an item for editing by clicking on its Title or Name. See the section below called 
Template - Edit for information on the edit screen.
Help: Opens this Help Screen.

Changing Text and Color

(Note: You have to be logged into your hub in order to complete the following tasks)

 

1. Click the Extensions tab and then select the Template Manager button located in the
drop-down.

2. On the Template Manager: Styles page, check the box of the kameleon
(admin) template and then click the Edit button.

3. Change the Header to Light or Dark from the drop-down.
4. Change the Theme or main color of the backend by either choosing a color from the

drop-down or by selecting Custom (color specified below) and fill in a color code in
the Custom color box.

5. Save the changes by clicking Save & Close and a pop-up will appear saying Style
successfully saved.
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Plugins Manager

Overview

The Plugin Manager allows you to enable and disable Joomla! Plugins and to edit a Plugin's
Details and Parameters.

The Plugin Manager can be accessed by selecting "Extensions" > "Plugin Manager" from the
drop-down menu on the Back-end of your HUBzero installation.

Plug-in Name: The name of the plug-in. The name explains where the plug-in is located
and what the plug-in is for.

For example: “Dashboard-Collections” means that the plug-in is on the user’s
Dashboard with a module for Collections.

Status: If the plug-in is viewable on the Hub or not.
Enabled: The plug-in is available on the frontend and on the backend of the Hub.
Disabled: The plug-in has been removed from the frontend of the Hub but is still
accessible on the backend.

Ordering: Where the plug-in is on the master list of plug-ins. This list can be seen when
plug-ins are being enabled the ordering determines how the plug-in is displayed in the
drop-down.
Type: The location of the plug-in.

This is the first part of the plug-in’s title.
Element: What the plug-in is implementing.

This is the second part of the plug-in’s title.
Access: Who is able to view or use the plug-in.

Public: All visitors or users on the Hub are able to view and use the plug-in.
Registered: Only registered users are able to view and use the plug-in.
Special: Only users given special permissions can access and use the plug-in.

ID: The identification number given to the plugin after it was created on the Hub. This
allows for easier search results.

Column Headers

 

#: An indexing number automatically assigned by Joomla! for ease of reference.
Checkbox: Check this box to select one or more items. To select all items, check the
box in the column heading. After one or more boxes are checked, click a toolbar button
to take an action on the selected item or items. Many toolbar actions, such as Publish
and Unpublish, can work with multiple items. Others, such as Edit, only work on one
item at a time. If multiple items are checked and you press Edit, the first item will be
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opened for editing.
Plugin Name: The Name of the Plugin. Click on the Name to open the Plugin for
editing.
Enabled: A green tick or a red X showing whether the use of the component is
enabled/disabled. Click the icon to toggle the item between enabled and disabled.
Order: The order to display items. If the list is sorted by this column, you can change the
order by clicking the arrows or by entering the sequential order and clicking 'Save
Order'. Note that the display order on a page is set in the Parameters - Advanced
section for each Menu Item. If that order is set to use something other than 'Order' (for
example, 'Title - Alphabetical'), then the order value in this screen will be ignored. If the
Menu Item Order parameter is set to use 'Order', then the items will display on the page
based on the order in this screen.
Access Level: Who has access to this item. You can change an item's Access Level by
clicking on the icon in the column. Current options are:

Public: Everyone has access
Registered: Only registered users have access
Special: Only users with author status or higher have access

Type: The Type of the Plugin. Possible types are: authentication, content, editors,
editors-xtd, search, system, user, and xmlrpc. These are also the names of the
subfolders where the Plugin files are located. For example, Plugins with a Type of
"authentication" are located in the folder "plugins/authentication".
File: The name of the Plugin files. Each Plugin has two files, a ".php" file and a ".xml"
file. So, for example, the Authentication - Joomla! plugin has two files: "joomla.php" and
"joomla.xml".
ID: The ID number. This is a unique identification number for this item assigned
automatically by Joomla!. It is used to identify the item internally, for example in internal
links. You can not change this number.
Display #: The number of items to display on one page. If there are more items than
this number, you can use the page navigation buttons (Start, Prev, Next, End, and page
numbers) to navigate between pages. Note that if you have a large number of items, it
may be helpful to use the Filter options, located above the column headings, to limit
which items display (where applicable).

Toolbars

Enable: To enable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the "Enabled" column.
Disable: To disable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the "Enabled" column.
Edit: Select one item and click on this button to open it in edit mode. If you have more
than one item selected (where applicable), the first item will be opened. You can also
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open an item for editing by clicking on its Title or Name.
Help: Opens this Help Screen.

List Filters

You can filter the list of items by typing in part of the Title or the ID number. Or you can select a
combination of Category and Published State.

Filter: If you have a large number of items on the list, you can use this filter to find the
desired item(s) quickly. Enter either part of the title or an ID number and press 'Go' to
display the matching items. You can enter in whole words or part of a word. For
example, "ooml" will match all titles with the word "Joomla!" in them.

Filter by Type and State: The selections may be combined. Only items matching
both selections will display in the list.

Select Type: Select a Type from the drop-down list box to select only Plugins of this
Type.
Select State: Select a state (Enabled or Disabled) from the drop-down list box to select
only Plugins with this state.

Edit Plugins

You can edit details and parameters for Plugins. Some Plugins have several parameters, while
others don't have any.

Details: The Details section is the same for all Plugins, as follows:
Name: The Name of the Plugin.
Enabled: Whether or not this Plugin is enabled.
Type: The Type of the Plugin. This value cannot be changed.
Plugin File: The name of the Plugin file. Each Plugin has two files with this name. One
has the file extension ".php" and the other has the file extension ".xml".
Access Level: Who has access to this item. Enter the desired level using the drop-
down list box. Current options are:

Public: Everyone has access

Registered: Only registered users have access
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Special: Only users with author status or higher have access

Order: The order this item will display in the Manager screen. Use the drop-down list
box to change the Order. You can select 'First' or 'Last' to make this the first or last item.
Or you can select an item from the list. In this case, the current item will be listed just 
after the item you select. Note that the Order can also be changed in the Manager
screen.
Description: The description of what this Plugin does. This cannot be changed.
Parameters: This will vary between plugins.

Reordering

1. Log in to the backend of the Hub and access the Extensions tab.
2. Click on the Plugin-in Manager navigate to the Plug-in Manager: Plug-ins page.
3. Locate the column labeled Ordering and then click on the title of the column.
4. Arrows will appear on the left side of the numbering.
5. To begin reordering click the arrows up or down to reorder the plug-ins.
6. Save the changes by clicking the Save icon.

Enabling a Plug-in

1. Log in to the backend of the Hub and access the Extensions tab and then click on Plug-
in Manager.

2. Locate the plug-in that needs enabling and select the box beside the plug-in’s name.
3. Click Enable to enable the plug-in.
4. The plug-in will now be useable on the frontend of the Hub.

Editing a Plug-in

1. Log in to the backend of the Hub and access the Extensions tab and then click on Plug-
in Manager.

2. Locate the plug-in that needs editing and select the box beside the plug-in’s name.
3. Click Edit to begin editing the plug-in.
4. Click Save & Close to save the newly edited content.
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Disabling a Plug-in

 

1. Log in to the backend of the Hub and access the Extensions tab and then click on Plug-
in Manager.

2. Locate the plug-in that needs disabling and select the box beside the plug-in’s name.
3. Click Disable to disable the plug-in.
4. The plug-in will now be removed from the frontend of the Hub, but still accessible from

the backend.
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Uninstalling

Overview

See Uninstalling Extensions in the Web Developer's Guide for details.
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Authentication

Why it matters?

By default, your hub comes configured to allow local account creation and authentication. In
addition to this default option, HUBzero gives you the ability to extend the authentication
process by adding support for third party services, like Facebook, Google, and LinkedIn. Using
one or more of these providers, users are given a "single sign-on" experience, while easing the
barriers to entry caused by the account creation process. Plus, as more social networking
features are developed for the hubs - like posting new resources to your Facebook wall - users
will already have that link setup between their hub and Facebook identities.

In brief, that's the principle behind offering multiple authentication options to users. Keep
reading to find out how to set it up on your hub!

Setup

Prior to starting this process, you will have to register an "app" for your hub on a given
provider's website. A few examples include:

https://developers.facebook.com/apps
https://developer.linkedin.com/ (go to "API Keys")
https://developers.google.com/ (go to the API console)

NOTE: the information above is accurate as of Aug 2012. It will undoubtedly change. Exact
steps and terminology differs between providers.

Whichever provider you're interested in, you'll need to register a new app to obtain an app
ID/key and secret (terminology may be slightly different between providers). Once you've
completed the registration process and obtained the API key and secret, you can jump over to
the hub.

NOTE: the Oauth protocol requires the specification of a redirect URI. Most of the providers
mentioned above require you to specify the redirect domain (usually just your hub URL). The
Google API requires you to specifically list any redirect URI's that will be used. These should be
as follows:
(HUBzero 1.1 - see image below)
https://yourhub.org/index.php?option=com_user&task=login&authenticator=google
https://yourhub.org/index.php?option=com_user&task=link&authenticator=google
(HUBzero 1.2)
https://yourhub.org/index.php?option=com_users&task=user.login&authenticator=google
https://yourhub.org/index.php?option=com_users&task=user.link&authenticator=google
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Setup begins in the administrative interface for your hub. First, navigate to "Extensions -> Plugin
Manager", and filter the results to the "authentication" type.

 

Next, select the plugin you desire to enable (we'll use Facebook in this example).

In the plugin edit screen, fill in the appropriate values for App ID and Consumer Secret as
obtained above. Also be sure to enable the plugin.

 

                           88 / 209



HUB MANAGERS
 

That's about it! Now, when you go to your hub's login page, you'll see a new option for
Facebook login.

 

More details

What happens if someone already has a local hub account, but wants to start using a
new third party provider?

Users that already have hub accounts can go to the accounts tab of their members page. From
there, they can link their existing account with external providers. Additionally, if a user tries to
log in with an external account that doesn't match one used on the hub before, we check to see
if we can match them with an already existing hub account prior to talking them through the new
account creation process.

Purdue Hubs

In addition to the authentication options mentioned above, HUBzero has also developed an
authentication plugin for the Purdue Central Authentication Service (CAS). If you're interested in
taking advantage of this service, follow the instruction here: 
https://www.purdue.edu/apps/account/docs/CAS/CAS_information.jsp to register your hub with
the Identity and Access Management Office at Purdue. Once this is done, simply turn the plugin
on and you'll be all set.

Other institutions or universities may find the Purdue CAS plugin a good template for developing
their own CAS authentication plugin. If you're developing a plugin that uses Oauth, consider
using the Facebook plugin as a starting point.
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Answers
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Blog
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Citations
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Collections
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Cron
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Events

Categories

Creating a category

Click “New” (green circle with a plus sign) in the upper right portion of the page.

You will be presented with a form to enter your new category. Only the field labeled “Title” is
required.
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When done, click “Save” (the icon that looks like a floppy disk) in the upper right portion of the
page.

Editing a category

To edit a category, click the title in the category listing or check the box next to the title and click
the “Edit” button in the upper right of the page.

All other steps are identical to category creation above.

Deleting categories

To delete one or more event categories, check the box next to the category you wish to delete
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and hit the “Delete” button in the toolbar located at the top right of the page.
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Groups
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Polls

Adding a Poll

To add a new poll to you HUB:

1. Log on to the backend. (https://yourhub.org/administrator).
2. Navigate to "Components -> XPolls" on the main menu bar.
3. Click the "New" button in the top right corner of your screen to add a new poll.
4. Fill in the details of your poll in the fields provided.
5. Select "Save".

 

Note: Users can only vote on the most recent open poll, but they can view results for all of the
published polls.
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Projects

Component Configuration

The Projects component has a number of configuration parameters that let you customize
projects on your hub. Go to /administrator ? Components ? Projects ? Options to edit
settings. Your options are explained below.

 Component ON/OFF Main switch of projects on your hub. When turned off, /projects
will redirect to hub's home page.
 Collect grant info at setup? Include/hide a section with questions about grant
information, e.g. [NSF] grant id, title, PI and award amount, at project setup. Some hubs
collect this information to provide larger disk space quotas for sponsored projects.
Setup - 'Agree to Terms' screen Enable/disable 'Agree to Terms' step at project setup.
Warning: this setting should be set only once at initial hub setup. Once enabled, do NOT
disable. Disabling the agreement step will render all projects currently in setup as
inactive. On the other hand, enabling the agreement after it was disabled will force
project creators to return to setup stage and accept the Terms. It is generally
recommended to have the agreement step enabled.
Allow project settings editing? Enable/disable a screen to edit project settings after
project setup.
Ask about sensitive data? Include/hide a question about sensitive data
(HIPAA/FERPA/Export Control) at project setup. There is an optional approval process
for projects containing sensitive data.
 Must approve sensitive data projects? Require approval for sensitive data projects. If
approval is required, a project with sensitive data will not be immediately available to
project team. An approval has to come from user(s) in admin group specified in
"Sensitive data reviewers group" parameter. Learn more about managing sensitive data
projects. 
URL to Privacy Terms Shown at project setup, when user needs to agree to Privacy
Terms.
URL to HIPAA information The Health Insurance Portability and Accountability Act of
1996 (HIPAA) rules create a framework to protect the privacy and security of patientâ€™s
and health plan memberâ€™s health information. When including a question about
sensitive data, provide a URL to explain HIPAA rules.
URL to FERPA information FERPA is the Family Educational Rights and Privacy Act
and is a federal law that was enacted in 1974. FERPA protects the privacy of student
education records. All educational institutions that receive federal funding must comply
with FERPA. When including a question about sensitive data, provide a URL to explain
FERPA rules.
Restrict project creation to group Alias of a group whose members can create
projects. When set, all other users will not be able to create new projects on the hub.
Admin group Alias of an administrative group that gets notified when a new project is
created or over quota
Sensitive data reviewers group Alias of an administrative group that can access a
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special project listing to review info on HIPAA/FERPA/export control.
Sponsored projects reviewers group Alias of an administrative group that can access
a special project listing to review and edit sponsored project information and bump up
quota.
Minimum characters in name Min number of characters a project alias name can
contain.
Maximum characters in name Max number of characters a project alias name can
contain.
Reserved project names Comma-separated list of words and character combinations
that cannot be used as project alias names. These are usually reserved for component
task names used in features in development.
Files Git repo path Master path for storing project files Git repos. Default path:
/srv/projects. The system administrator needs to ensure the path exists and is writable
by www-data before any project is created.
Files repo path is... relative to web root/ absolute. Default value: absolute.
Git path Path to Git. Default: /usr/bin/git
Default quota (GB) Default disk quota for project files repos, in gigabytes. Note: admins
can overwrite the default value and set specific project quota when editing a project in
the back-end. When default value is overwritten for a specific project, any changes to
default value have no effect in this particular project and must be adjusted manually
when required.
Premium quota (GB) Premium disk quota for project files repos, in gigabytes. Premium
quotas are usually assigned for approved grant-sponsored projects.
Quota warning at (%) Issue disk quota warning when disk space is used at a certain
percentage amount of the given quota. Default value: 90.
Publication quota (GB) Default disk quota for published files, in gigabytes.
Premium publication quota (GB) Premium disk quota for published files, in gigabytes.
Image path File path to project images (thumbnails). Default: /site/projects
Default picture Path to default placeholder picture for project thumbnail. Default path:
/components/com_projects/assets/img/project.png
Log activity Enable/disable detailed activity logging. The stored logs track page views
and activity by type within projects and can help analyze usage patterns. 
Messaging Enable/disable hub messaging. Messages are sent to invited project
members, to project managers about project status changes or to publication authors
about publication status changes. Turning off messaging may be useful in test hub
environments. On live hubs it is highly recommended to keep messaging enabled.
Default privacy Default privacy for newly created projects: private or public.
Browse paging limit Number of projects per page on Projects Browse page.
Side module item limit Limit of items (files, notes etc.) in side modules of each project
page.
Project group prefix Prefix for project group name (system group provisioned for each
project to handle permissions). Default: pr-. Warning! Never change the value once
configured at initial hub setup.
URL to documentation URL to a page with the projects user guide. By default links to
/projects/features page briefly describing project features.
Auto-install Check database setup on every visit and automatically add missing
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database entries. When turned off, system administrators will need to manually install
database updates when new features are added.

Project Files Configuration

Project Files configuration is found under /administrator ? Extensions ? Plug-in Manager ?
plg_projects_files. Below is a list of Project Files plugin parameters explained:

Max Upload Size (Bytes) Maximum upload size for project files. The value should not
be greater than the file upload limit in your hub's php configuration.
Max Download Size (Bytes) Maximum download size for project files. This setting is
only used in case of batch downloads, to guard against archival packages getting too
large for the server to handle. Individual file downloads are not checked against this
parameter.
Reserved Directory Names Comma-separated list of names that are not allowed for
top-level directories within project files repos. Used to reserve directory names for
features in development.
Google Connection Enabled Enable GDrive connection. Will not work without Google
Client ID, Secret and API key entered.
Connected Projects Comma-separated list of aliases of projects that can connect to
GDrive. Empty field means ALL projects can connect.
Google Client ID Client ID for web applications from Google API Console. See 
instructions for setting up GDrive Connection for projects.
Google Client Secret Client Secret for web applications from Google API Console. See 
instructions for setting up GDrive Connection for projects.
Google API Key API key from Google API Console. See instructions for setting up
GDrive Connection for projects.
Auto Sync Frequency of automatic sync with Google, when GDrive connection is
enabled for projects. 
Enable LaTeX Compile Enable compile feature for .TEX files
Path to LaTeX Path to pdflatex. Default: /usr/bin/
Path to Ghostscript Path to Ghostscript (used to produce images out of PDF for
browsers that cannot embed PDFs. Default: /usr/bin/

Enabling GDrive Connection for Project Files

To enable GDrive connection for hub projects you would need a Google account for your hub
with API access enabled. Because your Google email address and profile picture will be
displayed to users as they connect via projects, it is best to create a new Google account
representing your hub, rather than using your personal account.

To sign up for a Google account, follow a Sign Up link on Google Accounts
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Once you have a Google account, login to Google API Console and click the button to Create a

Project: 

 

Next you will be asked to selected services for your new API project. Turn on Drive API and

Drive SDK services, accepting service terms. 

 

Go to API Access tab in your API project and click the button to Create an OAuth 2.0 client ID: 
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On Branding Information screen enter Project Files to Google Drive Connector under Product
name. For the Product logo we recommend that you use HUBzero image at 
http://hubzero.org/site/media/images/sync.png. Enter your hub URL for Home Page URL and go

to next screen. 

 

On Client ID Settings screen choose Web application as Application type, enter your hub host

name and click on Create client ID 

 

Once your Client ID for web applications is created, click to Edit settings and change Authorized

Redirect URI to /projects/auth 
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Now you have all you need to enable GDrive Connection for projects in your hub. Login to your
hub's administrator back-end, go to Plug-In Manager and open Project Files plugin settings.
Choose Yes for Google Connection Enabled parameter and fill in Google Client ID, Client
Secret and API Key under plugin Basic Options.

If you want to offer GDrive connection for selected projects only, enter the aliases of those
projects under Connected projects. Another optional setting is Auto Sync, which allows you to

set desired auto sync frequency. 

 

Now selected or all projects should have GDrive connection enabled. Individual creators of
those projects will now be able to see the Connect button in Project Files and establish the
connection. GDrive Connection User Guide available at 
/documentation/1.2.0/users/projects.projectfiles.

Managing Sensitive Data Projects

Sensitive data can include personal, financial, and legal information, as well as information
protected by state or federal laws and by university policy. Federally-protected restricted data
include all individually identifiable health information (HIPAA-protected information), student
records and grades (FERPA-protected information).

As a hub manager, you need to have a plan for managing projects containing sensitive data. 
"Ask about sensitive data?" parameter in Projects component configuration offers three
options: 

1. No - do not ask about sensitive data. The question about data will then be omitted
during project setup. Project creator will not be warned about storing sensitive data and
can proceed with project setup. Use this option on hubs where data sensitivity is not an
issue or your hub is otherwise protected. You may want to include a clause about
sensitive data in your site usage terms.

2. YES, with one general question - project creator will need to agree not to store any

sensitive data in the project. The question asked will look like shown below: 
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3. YES, with HIPAA/FERPA etc. options - details on sensitive data will be presented.
Only certain types of sensitive data are allowed, upon expert approval. The picture

below shows all presented options expanded. IRB and FERPA may be allowed. 

"Must approve sensitive data projects?" parameter in Projects component configuration
controls what happens when user checks sensitive data box(es) on screen above and proceeds
with project setup. If administrator approval is required, the project will fall into suspended status
immediately project setup is complete:

Administrator(s) in "Sensitive data reviewers" group (assigned in component parameters) will
get notified by email of a new project requiring approval. The link to the page to manage and
approve sensitive data projects will be included in the email. This protected page can be found
at /projects/browse/?reviewer=sensitive. Reviewers see a list of projects requiring approval and
take action by clicking on Approve button:

The approval screen provides an area to communicate with project creator with or without
project approval.

As soon as a project is approved, team members get notified and can start using their project.

Managing Sponsored Projects

Hubs that offer Projects as a data management solution for faculty may want to collect awarded
grant information to allocate the appropriate amount of data storage space to sponsored
projects. To turn on grant information questions, go to Projects component configuration and
enable "Collect grant info at setup?" setting.

In the final step of project setup project creator will be able to fill out this information: 

 

When grant information is filled out, dedicated reviewers (members of admin "Sponsored
projects reviewers" group assigned in component configuration) will get notified by email with
a link to manage and approve projects for larger disk space. The protected page can be found
at /projects/browse/?reviewer=sponsored. Reviewers see a list of projects requiring approval
and take action by clicking on Manage button:

The approval screen provides an area to communicate with project creator, approve or reject
disk space increase.
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Approved projects automatically get their project disk space quota upgraded to the Premium
Quota specified in component configuration

Project managers can add/edit grant information at any time after a project has been created
and optionally re-submit this information for administrator approval. The grant information would
show up under Edit Settings:

Enabling Publishing

Projects integrate a publishing engine to get project materials delivered to the world in the form
of web publications. Each publication receives a Digital Object Identifier so that others can cite
it. Public can write reviews and add ideas to the Wish List for each publication.

Publication versus Resources

Hub Publications look and function much like hub Resources. In fact, Publications are meant
to replace Resources in the foreseeable future, once all resource types are supported in the
new publishing process. As of today, users can publish documents and databases (if DataStore
Lite is enabled). Next in line for publication are project notes, tools and external links. If your
new hub is not planning on publishing tools other than Workspace Tool, you can enable 
Publications on your hub and turn off Resources. On the other hand, if you are using 
Resources extensively or plan to immediately publish tools, it is best NOT to enable 
Publications for the time being to avoid any possible confusion.

Steps to enable Publishing

1. Ensure that Auto-install option is set to ON in component configuration.
2. Go to /administrator ? Extensions ? Plug-in Manager and enable Project Publications
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plugin (pls_projects_publications)
3. Go to yourhub/projects and refresh the page once. At this point the auto-install script

should have done the work of checking hub database structure and adding anything
missing.

4. Next go to /administrator ? Components ? Publications ? Options and make sure 
Component ON/OFF parameter is set to ON. Note: if you do not see Publications in
the component menu, you can access it by going to
/administrator/index.php?option=com_publications.

5. Configure publishing as needed, following the detailed explanation of Publications
Component Configuration.
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Publications

Component Configuration

Publications component configuration controls the display of publications pages, as well as the
publication submission flow. To edit settings, go to /administrator ? Components ?
Publications ? Options. Your options are explained below.

 Component ON/OFF Enable/disable Publications on your hub. When turned off,
/publications will redirect to /resources.
Auto-approve Automatically approve new submissions.
Auto-approved Users A comma-separated list of login names of users whose
publication submissions get auto-approved.
Email authors Email contributors when administrator make changes to status of a
publication.
Default category Optionally set the browsing category of newly created publications to
the specified value if exists. Default: dataset
Default picture Default placeholder thumbnail image for all publications. Default: 
/components/com_publications/assets/img/resource_thumb.gif
Default tool picture Default placeholder thumbnail image for tool publications. Default: 
/components/com_publications/assets/img/tool_thumb.gif
Default video file thumbnail Default placeholder thumbnail image for video-type files in
publication gallery. Default: /components/com_publications/assets/img/video_thumb.gif
Default image file thumbnail Default placeholder thumbnail image for image-type files
in publication gallery. /components/com_publications/assets/img/gallery_thumb.gif
Publication file path Master path for storing published data. Default: /site/publications

Digital Object Identifiers.

All required fields must be filled for the DOI service to work. If Service or Shoulder are left blank,
publications will be released without a DOI. If other required fields are left blank, there will be a
failed attempt to create a DOI resulting in error for end-user.

About DOI link A link to an explanation of what Digital Object Identifiers (DOI) are. 
[optional]
DOI shoulder Shoulder for issuing DOIs (what goes after doi:) [required]
DOI handle prefix Prefix for DOI handles if required.
DOI service DOI service URL [required] 
DOI Service User/Password DOI Service User/Password [required]
DOI XML Schema URL of XML validation schema [required]
DOI publisher Publisher name (may use full Hub name) for DOI service. Defaults to
Hub name.
DOI resolve url URL for resolving DOIs. Default: http://dx.doi.org/
DOI verify url URL for verifying DOIs
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-------------------------------

Supported Tag A tag to indicate organization-supported publications.
Supported Link A link to describe organization-supported publications.

Show/hide publication information

Next series of parameters lets you show/hide the following data/sections on the publications
page and/or during draft editing:

Contributors
Ranking
Rating
Date
Citations
Tags
Metadata
Release Notes
Access
License
Gallery
Audience

-------------------------------

Suggest license Allow users to suggest licenses. License suggestions get sent to
administrators via support tickets. Administrator can then add a requested license via
Publications back-end interface.
URL to Terms of Deposit URL to a page with information on Terms of Deposit. This
field is required. No value results in an invalid link at pre-publication review screen.

Enabling LinkedIn Share Plugin

(Note: You have to be logged into your hub in order to complete the following tasks)

 

1. Click the “Components” tab and then select the “Publications” button located in the
drop-down.

2. On the Publications page, select the “Plugins” tab.
3. Click the title of the “Publications -Share” plugin.
4. Under the “Basic Options” section, enable the LinkedIn icon share plugin by changing

the radio button to “Yes”.
5. Click the “Save & Close” button to save the changes and navigate back to the
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Publications page.

Enabling Pinterest Share Plugin

(Note: You have to be logged into your hub in order to complete the following tasks)

 

1. Click the “Components” tab and then select the “Publications” button located in the
drop-down.

2. On the Publications page, select the “Plugins” tab.
3. Click the title of the “Publications -Share” plugin.
4. Under the “Basic Options” section, enable the Pinterest icon share plugin by changing

the radio button to “Yes”.
5. Click the “Save & Close” button to save the changes and navigate back to the

Publications page.
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Resources

Types

Users may contribute many types or categories of resources. All HUBs come with a default set
of types. They are:

Animations
Courses
Downloads
Learning Modules
Notes
Online Presentations
Publications
Series
Teaching Materials
Tools
Workshops

Some types can be contributed by any user via the front-end "contribute" component. Some
types, such as Learning Modules or Series cannot presently be contributed via the front-end
due to their complex nature (more on this below).

Creating New Types

The default list of types may not completely suit your needs and you may wish to add your own,
new types. This can be done from the administrative back-end of the site by following these
steps:

1. Login to the administrative back-end.
2. Once logged in, find "œComponents"• in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of all the
installed components on your HUB.

3. Select "Resources"• from the list.
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Once the "Resources Manager"• page has loaded, select "Types"• from the sub-menu found
under the "Resources Manager"• title.

You should now be presented with a list of all the "Main Types"• (selected by default). There are
multiple categories of types. If not already selected, select "Main Types" from the "categories"•
option found directly above the list or navigate the listing until you see those designated as
"Main Types". These are the primary types of resources users will be able to contribute, browse,
etc.

Click the title of a type to edit it or click "New Type" (green circle with a plus sign in the middle)
from the toolbar on the top right of the page.
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Fill in the title field (what you want this type to be called) and select "Main Type" from the
category list. You may then optionally fill in a description (longer explanation) of this type.

Decide if this resource type can be contributed from the front-end "œcontribute"• component by
checking/unchecking the "contributable"• checkbox. Due to the complex structure of some
resources, the front-end "contribute"• component cannot handle the creation of some resource
types. This checkbox ensures what such a resource type does not accidently show up as a type
the user can self contribute.

Next, you may decide what custom fields you wish to have filled in by the user for that resource
type. Options are single-line text boxes, multi-line text areas, checkboxes, select list (pull down),
radio options, pre-defined options (language list, etc.). A field may be required or not.
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Click "Save"• (icon looks like a floppy disk) in the toolbar on the top right of the page.

New resource types should now be available as a resource option and changes to types should
take affect immediately.

Enabling LinkedIn Share Plugin

Note: You have to be logged into your hub in order to complete the following tasks.

 

1. Click the “Components” tab and then select the “Resources” button located in the drop-
down.

2. On the Resources page, select the “Plugins” tab.
3. Click the title of the “Resources-Share” plugin.
4. Under the “Basic Options” section, enable the LinkedIn icon share plugin by changing

the radio button to “Yes”.
5. Click the “Save & Close” button to save the changes and navigate back to the

Resources page.
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Support

Overview

Tickets
Messages
Resolutions
Abuse Reports
Tag/Group
Stats
ACL

Tickets

Tickets

Messages

To aid in responding to support ticket submissions, you may create custom message templates
for frequently used responses. Example responses include a "Ticket resolved" message sent
upon closing a ticket or a "Request for more information" message.

Messages may also includes placeholders where information that changes can be specified. For
instance your message template may include references to the specific ticket ID number or site
name. A "Ticket resolved" template could look like this:

Thank you for using the {sitename}, and for reporting this problem. We believe that your
issue (ticket #{ticket#} in our system) has been resolved. If you continue to have
problems please let us know. You may reopen a closed issue at any time by following
the link at the end of this message and adding a comment to the ticket.

Thank you for helping us to improve {sitename}!
--the {sitename} team

Here we have two placeholders: {ticket#} and {sitename}. The placeholders are replaced with
their current value at the time of composition. When chosen from the select box under
"Comments" of the response form, the comments text box will be filled with the following:

Thank you for using the YourHUB, and for reporting this problem. We believe that your
issue (ticket #123 in our system) has been resolved. If you continue to have problems
please let us know. You may reopen a closed issue at any time by following the link at
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the end of this message and adding a comment to the ticket.

Thank you for helping us to improve YourHUB!
--the YourHUB team

Resolutions

Resolutions

Abuse Reports

Abuse Reports

Tag/Group

Tag/Group

Stats

The stats page gives a basic overview of support ticket activity starting at the beginning of a
chosen year, defaulting to the current year if none specified.

The following data is shown:

Tickets opened for the given year
Tickets closed for the given year
Tickets opened for the current month of the year
Tickets closed for the current month of the year
Tickets opened for the current week of the year
Tickets closed for the current week of the year
Open tickets
Unassigned tickets
Average ticket lifetime
A list of administrators and the number of tickets closed

closed for the given year
closed for the current month of the year
closed for the current week of the year

A line chart displaying Tickets Submitted (red) vs. Closed (green) on a monthly basis

Stats shown may also be filtered by group.
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ACL

The ACL (Access Control Layer) works in conjunction with a user login system to allow or deny
a user access to support tickets and various information or features of a ticket. 

Permissions may be set for individuals or entire groups of users. All members of a group will
inherit any permissions set for the group. If a user is a member of multiple groups with ACL
settings, the highest permissions will take affect. Take, for example, the following group
settings: 

Table 1: ACL Tickets Comments Private
Comments

Object Model Read Update Delete Create Read Create Read
dev (111) group yes yes yes yes yes yes yes
support
(222)

group yes no no yes yes no no

If user "john" is a member of both groups, his permissions will result as follows: 

Table 2: Resulting permissions Tickets Comments Private
Comments

Object Model Read Updat
e

Delete Create Read Create Read

john (333) user yes yes yes yes yes yesyes

Individual ACL settings take precedence over any other settings. Once again, take the following
two groups and their permissions settings. User "john" is a member of both groups. We then
add specific permissions settings for "john": 

Table 3: ACL Tickets Comments Private
Comments

Object Model Read Update Delete Create Read Create Read
dev (111) group yes yes yes yes yes yes yes
support
(222)

group yes no no yes yes no no

john (333) user no no no no no no no

The ACL in table 3 will result in the following permissions for user "john": 

Table 4: Resulting permissions Tickets Comments Private
Comments

Object Model Read Updat
e

Delete Create Read Create Read

john (333) user no no no no no nono

Note: A user will always have read access to tickets they submitted or are assigned to. This will
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even override any specific ACL settings. 
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Tags

Overview

Tags are like keywords or category labels. Tags help you categorize and find content, events,
and members which have something in common or similar interests. Tags can be added to
groups, profiles, resources, wiki pages, and events. 

To manager tags: 

1. First login to the administrative back-end.
2. Once logged in, find “Components” in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose “Tags” from the available options.

Creating a Tag
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1. Click “New” (green circle with a plus sign) in the upper right portion of the page.

2. You will be presented with a form to enter your new tag. Only the field labeled “Tag” is
required.

Admin
This is a flag that designates if a tag is an administrative tag. Admin tags are
only seen by administrators and are typically used for tagging content with
information that may not be relevant or desired to be known by front-end users.

Tag
The tag you wish to create.

Alias
An alternate version of the tag such as a pluralized spelling of the tag or
common abbreviation. For example, the tag “New York” may have an alias of
“ny”.

Description
A description or definition of the tag.
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3. Once you feel ready to save your changes, scroll back to the top of the page and click
“Save” (the icon that looks like a floppy disk) in the upper right portion of the page.

Editing a Tag

To edit a tag, click the raw tag, tag, or alias found in the tag listing.

All other steps are identical to tag creation.
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Merging Tags

Should a situation arise where two or more tags should really be one tag, you can merge tags.
To merge tags, check the box next to the tags you wish to merge and hit the “merge” button in
the toolbar located at the top right of the page.

You will then be presented with a list of the tags you want to merge (and how many items are
using each tag) and the options to either:

Merge the tags under another existing tag (ex: everything tagged with “h2o” and
“hydro” can be merged to just “hydro”) or
Merge the tags into a new tag (ex: everything tagged with “h2o” and “hydro” can be
merged to “water”)
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Click “Save” (the icon that looks like a floppy disk) in the upper right portion of the page to
perform the final merge. Note: This cannot be undone!

Deleting Tags

To delete one or more tags, check the box next to the tag(s) you wish to delete and hit the
“delete” button in the toolbar located at the top right of the page.
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Tools

Changing the Developer URL

When accessing a tool's development page, there is a link available under the "What's next?"
section on the right-hand side of the page (see the sample image below). This link should direct
the user to the yourhub.org/tools page corresponding to that particular hub. But if that is not the
case, the link can be changed quickly from the backend administrator interface; simply follow
the instructions below.

 

Begin by...

1. Logging into the Joomla! administrative interface corresponding to your site

2. Then, navigate to "Components -> Tools" from the main menu bar on the top of the
screen

3. Next, select parameters from the top-right corner of the page
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5. Locate the "Developer URL" field and ensure that it reads https://yourhub.org/tools

6. Select "Save" from the top-right corner
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Wiki
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Wishlist
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Resources

Approving Pending Resources

Depending on whether auto-approval for user-submitted resources on a hub is turned on/off,
you may need to watch for newly submitted resources awaiting for administrator approval to be
published on the hub. The administrative dashboard shows whether there are any resources
pending approval.

In the screenshot above, the dashboard says there are 49 pending resources. By clicking on the
link “49 pending resources”, you will be immediately taken to the resource manager. Resources
that need your approval will be marked with a distinct icon as seen in the screenshot below.
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You can publish a pending resource just by clicking on the orange status icon, or you can first
click on the resources title and select appropriate status from the detailed resource page, as
shown on the screenshot below.

From the detailed resource page you can also decide when the resource should get published
and unpublished by setting Start Publishing and Finish Publishing dates. As soon as a new
resource is published, it will appear in site search as well as in What's New area of the site.
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Tools

Contribtool

Contribtool is the process that manages the publishing process for tool resources on the hub.
There are nine states of a tool within Contribtool: 

 

Each state is associated with a set of tasks that either the tool developer or the hub
administrator must perform. We will refer to tasks the tool developer must perform as "user
tasks", and tasks the hub administrator must perform as "admin tasks". 

Preparation

To accomplish many of the admin tasks, the user acting as the admin must be a part of the
"apps" group. To be added to the "apps" group: 

1.  Login to the hub's administrative back end and find the "Groups" component. 
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2.  Type "apps" into the search box.
3.  Click on the number under the column "Total Members" 

 

  

4.  Type the admin's username into the Add input box, choose "Members" from the drop
down menu, and push the "Add users" button. 

 

  

Registering a Project
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The first step in Contribtool is for the tool developer to register the tool by filling out the tool
contribution form. This is a user task. Go to the web page https://yourhub.org/contribute
(substituting "yourhub.org" with the name of your hub). Use the "Getting Started" button in the
upper right side of the web page to start the contribution process. On the left side of the web
page, a list of contribution types will be shown. Choose the TOOLS contribution type. 

 

  

The tool registration form will be presented. The form asks for some basic information regarding
the name of the tool, a short description of the tool, and who can access the source code
repository. There are also fields available to add restrictions on who can run the tool once it has
been published, and who can access the Trac project area. All of the information on this page
can be changed at a later date, except for the tool name. Once the tool name has been
registered, it cannot be changed, so pick a good one. When the registration form has been
completed, push the "Register Tool" button at the bottom of the page, and the state of the tool
will be changed to "Registered" 
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Registered to Created

 

 

Once the tool has been registered by the tool developer, it is up to the administrator to create
the project. Creating the project is an admin task. Start by going to the web page
https://yourhub.org/contribtool. This page lists out all tool contributions on the hub. Tools that
require administrator attention are highlighted. If a tool has been registered by a tool developer,
but there are no tool contributions listed on the Contribtool web page, there may be a privileges
related error. Make sure the administrator account being used is a member of the "apps" group.
Instructions on how to do this are in the section labeled "Preparation". 
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The newly registered project should be highlighted on the Contribtool web page. Choose this
project by clicking on the tool name, which is a link to it's tool status page. The tool status page
contains the tool information that the developer provided on the registration form and a set of
Developer Tools on the left side of the web page. On the right side of the web page, the "What's
next?" status is provided, which gives information regarding the steps that need to be completed
before the tool can be published on the hub. Any tasks that have been checked off have been
completed. Tasks that have an arrow next to them are tasks that can be completed now. 

 

 

Special for the administrator, there is a section of "Administrator Controls" on the left side of the
page, under the Developer Tools. To create the tool project, the admin must press the link
labeled "Add Repo". This starts a process that creates a Subversion source code repository,
Trac project wiki pages, and sets up access for the tool for the users listed on the development
team. When the process has completed, the results are displayed for the administrator to see. A
green box generally means nothing catastrophic has happened and the tool project are has
been successfully created. In the case something fails, a red box will be displayed listing the
errors encountered. Running the process multiple times by repeated presses of the "Add Repo"
link generally has no harmful effects, in that if the pieces of the project area already exist, they
will not be overwritten, and if they do not exist, they will be created. 
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The last step to creating the tool project area is to flip the status of the project from Registered
to Created and pressing the "Apply change" button at the bottom of the Administrator controls. 

Created to Uploaded

 

 

After the tool project has been created, the tool developer needs to upload their tool source
code into the source code repository. This is a user task. Instruction listing out the commands
involved with upload source code to the project's source code repository are easily accessible
from the tool status page in Contribtool. Start by accessing the Contribtool web page
https://yourhub.org/contribtool. Find the tool project on the Contribtool web page, and click on
the tool project's name. This is a link which leads to the tool status page. While in the Created
state, the "What's next?" section on the right side of the web page contains a link to the
instructions. We will review the requirements for installing a tool in the HUB environment and
the process of doing so. 
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There are four requirement for installing a tool in the HUB environment: 

1.  Source code
2.  Graphical User Interface
3.  Makefile
4.  Invoke script

 

Source code includes all files related to running the application with the tool.xml and possibly a
wrapper script as the exceptions. Source code is needed as a part of the installation process.
No binaries from the source code of the application should be stored in source code repository.
It is alright to store binary data files, like images, in the source code repository, but in most other
cases, storing binaries from the application instead of the actual source code leads to future
compatibility problems, even when the binaries claim to be platform independent. 
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All tools need a graphical user interface. There are several toolkits available including Qt, GTK,
wxWidgets, and Tcl/Tk. If your tool does not already have a graphical user interface, we suggest
using Rappture (http://rappture.org). With Rappture, you can quickly develop a graphical user
interface that can guide users through the process of running the tool and viewing results, all in
one application. Rappture also include many hooks into the HUB infrastructure, which makes it
a great choice for tool developers. 

 

All tools need a Makefile. The Makefile holds the instructions for compiling and installing binary
files. Even tools that do not have source code that needs to be compiled still need a Makefile. 
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All tools need an invoke script. Invoke scripts hold details about how to launch to the tool in the
HUB environment. Generally, invoke scripts are very simple, one line calls to the HUB invoke
script with a few options. 

While generating the source code and graphical user interface are outside of the scope of this
tutorial, details will be given later regarding creation of a typical Makefile and invoke script. 

There are eight steps related to uploading source code to the source code repository. 

1.  Checkout a copy of the tool's source code repository.
2.  Add source code to the src directory of the tool's repository.
3.  Add a Makefile in the src directory of the tool's repository.
4.  Add tool.xml to the Rappture directory of the tool's repository.
5.  Check the middleware/invoke script.
6.  Test the code in the workspace.
7.  Clean the directories before committing.
8.  Commit the changes from the local copy of the repository.

All of these steps can be performed from within the workspace. 

The first step of uploading source code to the source code repository is to checkout a copy of
the tool's source code repository. This can be done by using the svn checkout command. 
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svn checkout https://yourhub.org/tools/toolname/svn/trunk toolname

In the example, replace "yourhub.org" with the name of the hub hosting the tool's source code
repository. Also, substitute the term "toolname" with the shortname of the tool. Executing this
command will download a copy of the tool's source code repository from the repository server,
hosted on "yourhub.org", and place the copy on the machine where the command was
executed. If the command was executed inside of a workspace, the copy of the tool's repository
server will be made inside of the workspace. This copy will be referred to as the local copy of
the tool's source code repository. The local copy of the repository will be stored in a directory,
with the name substituted for "toolname". 

The second step of uploading source code to the source code repository is to add source code
to the src directory of the tool's repository. This can be done with the svn add command. This
step involves (1) changing directories into the local copy of the repository, here referred to as
toolname, (2) copying source code files into the src directory, and (3) lastly using the svn add
command to notify the local repository that files need to be added to the source code
repository. 
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Line    Example:
  1       cd toolname
  2       cp /apps/rappture/examples/zoo/curve/curve.tcl src/curve.tcl
  3       svn add src/curve.tcl

All files will need to be added to the source code repository. They can be done one by one, as
shown above, or by directory. 

The third step of uploading source code to the source code repository is to add a Makefile to the
src directory. The svn add command will be used to complete this task. If a Makefile does not
exists, one can easily be created using a text editor. In the workspace, the gedit program is a
convenient text editor. From within the toolname directory, issue the command: 

 

gedit src/Makefile

If no Makefile exists, add the following text to the file. 
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Line    Example:
  1       all: curve.tcl
  2
  3       install: curve.tcl
  4           install --mode 0644 -D curve.tcl ../bin/
  5
  6       clean:
  7
  8       distclean: clean
  9           rm -f ../bin/curve.tcl

In this example, the source code is a single tcl script named curve.tcl. Since the source code
does not need to be compiled in this case, the "all" target is empty. If there was source code to
be compiled, line 2 would be tabbed in once and include a compile line like "gcc -o curve
curve.c". The install target, starting on line 3, is responsible for installing the executables and
related scripts into the ../bin directory. Executables should be placed in the bin directory. Line 4
is the action of the install target. It uses the shell program named "install" to move the files from
the src directory to the bin directory, and appropriately set the permissions of the file. The clean
target, on line 6, is responsible for removing files temporary files, usually left over from
compilation. The distclean target, on like 8, calls the clean target from line 6, and then removes
the tcl script that was placed in the bin directory by the install target. The distclean target is
responsible for removing any files that were generated be install target. After running the
distclean target, the local repository should be in the same state as when it was first checked
out. 

Once the Makefile has been created, save the file and exit the gedit program. Lastly run the svn
add command on the file src/Makefile to add it to the local copy of the source code repository. 

The fourth step of uploading source code to the source code repository is to add the tool.xml file
to the Rappture directory. To add the tool.xml file to the local copy of the source code
repository, first copy the file into the Rappture directory, then use the svn add command to
notify the local copy of the repository that a file needs to be added. 
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Line    Example:
  1       cp /apps/rappture/examples/zoo/curve/tool.xml 
            rappture/tool.xml
  2       svn add rappture/tool.xml

The fifth step of uploading source code to the source code repository is to check the
middleware/invoke script. Inside of the middleware directory, there should exist a file named
invoke. If the file does not exist, use gedit to create it, then add it to the repository using the svn
add command, just as was done for the Makefile in step 3. The invoke script is responsible for
setting up the tool environment and launching the tool when a user clicks the Launch button
from the tool resource page. The default invoke script looks like this: 

 

Line    Example:
  1       #!/bin/sh
  2
  3       /apps/rappture/invoke_app "$@" -t toolname
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In the example above, the invoke script calls the HUB invoke script located at
/apps/rappture/invoke_app. On older hub setups, /apps/rappture/invoke_app is a file that only
supports launching rappture applications. On newer hub setups, /apps/rappture/invoke_app is a
link to /apps/invoke/current/invoke_app, which is capable of launching all rappture applications
and a majority of non-rappture applications. 

The invoke_app script accepts a number of flagged options. Some of the more popular ones
include: 

-r  Rappture version (current, dev)
-t  tool name
-T  tool root directory
-e  environment variable to set
-p  add a path to the PATH environment variable
-C  command to launch the tool
-A  additional arguments to add to the command for launching the tool
-c  commands to start in the background before launching the tool, lik
e filexfer

The example above takes advantage of the -t flag to tell invoke_app that the name of the tool is
"toolname". The invoke_app script contains more details about the available flags and how to
use them. 

The last task of this step is to ensure the middleware invoke script has execute permissions.
This is accomplished by using the shell's chmod command: 

chmod 755 middleware/invoke

The sixth step of uploading source code to the source code repository is to test the tool in a
workspace. If the tool runs properly in a workspace when started from an invoke script, it is very
likely that it will run properly when installed in the hub environment. Testing the code in the
workspace also exercises the Makefile and invoke script, ensuring they are also functioning
properly. Here are the commands: 
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Line    Example:
  1       cd src
  2       make all install
  3       cd ../
  4       ./middleware/invoke -T $PWD

In the above example, the code is compiled and installed by (1) changing directories into the src
directory, and (2) issuing the command "make all install". The shell command "make" looks for a
file named Makefile, and runs the targets specified as its arguments. In this case, it runs the all
and install targets. Next (3) change directories back to the tool's root directory and run the
middleware/invoke script, providing the option "-T $PWD". Recall from earlier, the -T option
specifies the tool root directory. The $PWD environment variable hold the present working
directory, which in this case also happens to be the tool's root directory. When the Rappture
GUI appears, press the simulate button to make sure the tool runs correctly. 

It is important that this step is successfully completed by the tool developer. This is the same
sequence of events that the administrator will do when installing the tool in the HUB
environment. Any failures encountered while running this step will most likely be encountered
again when installing the tool in the HUB environment, so they should be resolved prior to
changing the tool status to Uploaded in Contribtool. 

The seventh step of uploading source code to the source code repository is to clean up the local
copy of the repository before committing. This will again utilize the Makefile located in the src
directory. Here are the commands: 
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Line    Example:
  1       cd src
  2       make distclean
  3       cd ../

Earlier the Makefile was setup with a distclean target to clean up all files generated from the
installation of the tool's source file. In this example, the distclean target of Makefile is called to
do the cleanup of the previous install. It is important to clean up the repository before
committing to avoid placing unnecessary binary and other temporary files into the source code
repository stored on the repository server. 

The eighth and last step of uploading source code to the source code repository is to commit
the changes from the local copy of the repository to the repository server. This is accomplished
by using the command svn commit. The svn commit command accepts the --message flag
along with a message. With every commit to the repository, a message should be included
detailing what is being committed. This will help later when searching for specific versions of the
tool in the source code repository. Commits can be made from any directory in the local copy of
the repository, but will only include files and directories underneath the present working
directory. For this reason it is usually convenient to commit from the local copy of the
repository's root (top) directory. Here is an example commit command with a message: 
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svn commit --message "initial upload of code"

After issuing the svn commit command, a prompt may appear requesting a username and
password. Enter the username and password credentials for the HUB hosting the tool's source
code repository. 

Once the tool's source code has been uploaded to the repository server, the tool's Contribtool
status can be changed to Uploaded. Go to the tool's status web page in Contribtool, it can be
found through the Contribtool web page:  

 

https://yourhub.org/contribtool.

To make sure the source code was successfully committed, use the Timeline link under the
Developer Tools section on the left side of the web page. The Timeline link will open a web
page with the tool's project area. Note that the tool's project area may have restricted access
that requires the user to login. The timeline lists out the most recent changes to the source code
repository. The most recent changes for uploaded code should be listed at the top. Make sure
the uploaded code is listed in the Timeline. 
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Back on the tool's status web page in Contribtool, there should be a "We are waiting for You"
section under the "What's next?" section on the right side. When ready to change the status of
the tool from Created to Uploaded, click the link labeled "My code is committed, working and
ready to be installed". Clicking the link will change the status. 

Uploaded to Installed

 

 

Once the tool has been uploaded by the tool developer, it can be installed in the HUB
environment. This is an admin task. Navigate to the tool's status web page in Contribtool. Under
the Administrator Controls section, on the left side of the web page, will be a link labeled Install.
Clicking the Install link will start the installation background process which performs an svn
checkout of the tool's source code repository into the /apps directory. The next step requires
that the administrator login to the system, become the "apps" user, and compile the code. This
can all be accomplished within a workspace.  
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Inside of a workspace issue the following commands in an xterm: 

 

 

Line    Example:
  1       sudo su - apps
  2       cd /apps/toolname/dev/src
  3       make all
  4       make install

Become the apps user by using the shell's sudo command. If there are errors while becoming
the apps user, go back to the beginning of this tutorial and ensure the login account being used
is a member of the "apps" group. Change directories to the tool's installed dev directory,
/apps/toolname/dev. Inside of the src directory, run the "make all" and "make install" commands
to compile and install the code. 

When the source code has been compiled and installed, go back to the tool's status page in
Contribtool, flip the status from Uploaded to Installed, and press the Apply change button.
Pressing the Apply change button will update the tool status web page. 
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On the updated page, a Launch tool link will be made available, on the right side of the page, in
the "What's next?" section. Click the Launch tool link and verify that the tool properly launches
and runs. 

 

 

Installed to Updated
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It is the tool developer's responsibility to test the operation of the tool and validate that it
generates acceptable results. The tool developer may find an error or otherwise needs to
update the code in the source code repository and have the tool reinstalled. Updating the tool is
a user task. Any new changes to the tool should be committed to the source code repository.
Next, the tool's status in Contribtool should be changed to the Updated state. Changing the
status will notify the administrator that the tool is ready to be installed again. 

Installed to Approved

 

 

When the tool developer feels the tool is working properly, the approval process can be started.
Tool approval is a user task. To approve a tool, the tool information page must be created. The
tool information page is the web page listing the authors of the tool, credits, publications, and
screen shots. To create the tool information page. Click the "Create this page" link in the
"What's next?" section on the tool status page in Contribtool. 
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During the process of creating the tool information page, the necessary information will be
collected and formatted. At the end of the process a preview page will be provided. The tool
developer will need to confirm the layout and information on the preview tool page. 

 

 

The tool developer will also need to choose a license under which the project will be published.
Be sure to replace the template text in the license with the appropriate information. 
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Finally, approve the tool by pushing the button labeled "Approve this tool". The status on the
tool's status page in Contribtool will automatically be updated. 

 

 

Approved to Published

 

 

To publish a tool in the Approved state, the administrator must click the Publish link in the
Administrator Controls on the tool's status page in Contribtool. This is an admin task. Clicking
the Publish link updates the database, exposing the tool information page on the HUB. From the
tool information page, the tool can be launched using the Launch tool link. The Publish link will
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run the publishing process and return the results to the administrator. Similar to the Installed
state, successful completion will result in a green box with results. Failure will result in a red box
with errors. After the results have been presented, flip the status from Approved to Published.
and press the Apply change button. 

 

 

Published to Updated
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When the tool developer is ready to start testing a new release of the tool, they will commit all
changes to the source code repository, and change the status on the tool's status page in
Contribtool, from Published to Updated. Changing the status from Published to Updated does
not unpublish of otherwise change the state of the already published tool. Changing the status
will notify the administrator that the tool needs to be reinstalled. From here, the Install-Approve-
Publish cycle continues. 

Published to Retire

 

 

The tool developer has the option of retiring a tool. Generally, published tools are not retired,
and live in perpetuity. Changing the status from Published to Retired places the tool in a state
where nobody can run it from the tool information page. The tool information page will still exist,
as a placeholder for the previously published resource. 
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Support Tickets
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Abuse Reports
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Store Orders
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Site Notices

Overview

1. First login to the administrative back-end.
2. Once logged in, find “Extensions” in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing items such as
“Module Manager”, “Plugin Manager”, etc.

3. Choose “Module Manager” from the available options.

4. You should now be presented with a list of all the modules installed on your site. There
are a variety of methods to find the specific module you wish to edit: you can filter by
selecting position, type, or even state (enabled, disabled). The site notice module would
be in position “notices” and of type “mod_notices”. You may also search for “notices”
in the filter search box or scroll to the bottom of the page and navigate your way through
the entire list. Once found, click the module name to edit it.
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5. Once in edit mode you will be presented with some options such as the title, position,
etc. Typically, you will not need to edit anything found in the “Details” section. The items
that will most often be changed are under “Parameters”. Here you can set the following:

Start Publishing
This determines when you wish the site notice to start’ showing on the site.

Finish Publishing
This determines when you wish the site notice to stop showing on the site.

Alert Level
3 levels available: low, medium, and high. This determines the appearance of
the site notice (such as eye-catching red for “high”).

Module ID
A CSS ID to be applied to the module. Typically, you will not need to change
this.

Message
The notice you wish to display.

Important! The “Position” must be set to “Notices”, otherwise the banner will not show
up, or it will not show up where you intended it to.

6. Once your parameters are set, move down to the “Menu Assignment” portion. This
section determines what pages of your site you wish the notice to appear on. This will
typically be set to “All”.
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Important! If the menu assignment is set to “none”, your notice will NOT appear on any
page of the site, even if it is published and the timeframe is within the publishing window
set in the “Parameters” section.  

7. Return to the top of the page and click “Save” (the icon that looks like a floppy disk) in
the upper right portion of the page.
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Scheduled Tasks

Overview

A cron component is available for managing and running scheduled tasks for your hub.

The Cron Job Manager can be found by selecting "Components" > "Cron" from the drop-down
menu on the back-end of your HUB installation.

What is cron?

Cron is the name of program that enables unix users to execute commands or scripts (groups of
commands) automatically at a specified time/date. It is normally used for sys admin commands.

A hub has a specific cron job that calls to the CMS. From there the code executes a list of jobs
that can be created, published/unpublished, modified, and deleted via the administrator
interface.

Create/Edit Jobs

When you create a new job, you will select the event to trigger. Each event calls to a specific
plugin and performs its own set of tasks.

All jobs have two sections that are the same: Details and Recurrence. The Parameters are
different for each event.

Details
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Event
This displays the system name of the module. No entry is allowed.

Title
The Title of the Module.

State
Whether or not the job is enabled. If "No", the job will not be run.

Recurrence

This is how often a job should be run. Several common values are provided--such as
"run once a day, midnight"--with the option to specify your own by selecting "custom"
front he drop-down list.

Recurrence

Parameters
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This will vary between events.
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Categories

Overview

Sections and categories in Joomla! provide an optional method for organizing your articles.
Here's how it works. A Section contains one or more categories, and each Category can have
articles assigned to it. One Article can only be in one Category and Section. 

For example, you might have a Section called "Pets", and categories called "Dogs" and "Cats".
Articles about dogs would be assigned to the "Dogs" Category, ones about cats the "Cats"
Category. So an Article about dogs would be in the "Pets" Section and the "Dogs" Category.
You could not have one Article that is in both the "Cats" and "Dogs" categories. To work around
this, you could either (1) create a new Category called "Cats and Dogs" or (2) create a second
Article to put in the second Category. 

Why Use Sections & Categories?

There are two main reasons you might want to organize your Articles in sections and
categories. 

List and Blog Layouts

First, there are built-in Menu Item Types in Joomla! that take advantage of this organization.
These are the Section Blog, Section List, Category Blog, and Category List. These Menu Item
Types (also called "layouts") make it very easy to show articles that belong to sections or
categories. As new articles are created and assigned to sections and categories, they will
automatically be placed on these pages according to the parameters you set for each page. 

For example, say you have a Section Blog layout for the "Pets" section, and say you have it set
to order articles starting with the most recent one first. When you add a new Article to the "Pets"
Section, it will automatically show on the "Pets" blog page as the first Article. You don't have to
do anything other than add the Article and assign it to the "Pets" Section. 

Organizing Articles in Article Manager

If you will have a large number of articles on your site, a second reason to use sections and
categories is to simply group the articles so you can find them. For example, in the Article
Manager, you can filter articles based on Section or Category. So if you have 200 articles in
your site, you can more easily find an Article if you know it's Section or Category. 

Sections and Categories vs. Menu Organization

It is important to understand that, just because Joomla! uses a 3-tier organization level for
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articles (Section ? Category ? Article), this has nothing to do with the structure of the menus on
your site. For example, your site could have one menu level or six menu levels. 

Other Types of Categories

There is also a potential for confusion about categories. Sections are only used for articles.
However, categories are also used for other components, including Banners, Contacts, News
Feeds, and Weblinks. These categories are completely different from Article categories and are
set up in different screens in the back end of Joomla!. So when you see something about
categories, it might refer to Article categories or it might refer to categories for these other
components. 

Creating a Section & Category Hierarchy

Coming soon. 
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Creating/Editing

Creating an Article

1. First login to the administrative back-end.
2. Once logged in, find “Content” in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as “Article
Manager”, “Article Trash”, etc.

3. Choose “Article Manager” from the available options.

4. Then click the "New" toolbar button.
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5. The New Article screen contains options for categorizing and naming the article, editing
content and selecting parameters.

Enter a title in the "Title" field. This is used when the article title is displayed.
Enter an alias in the "Alias" field. The alias is used to refer to the title and is
important for the URL of the page. If you do not enter anything Joomla! will
generate it for you.
Select a "Section" and "Category" using the drop down menus.
Choose whether the article is published or not using the "Published" radio
buttons.
Choose whether the article will be displayed by the Frontpage component using
the "Front Page" radio buttons.

6. You may also choose Parameters for the article. Click on each section to view the
parameters and change the settings to suit your requirements.

7. Click the "Save" or "Apply" toolbar button to save your article.

The "Save" toolbar button will save your changes and return you to the Article
Manager screen.
The "Apply" button will save your changes but leave you in the Article Edit
screen.
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Editing an Article

1. First login to the administrative back-end.
2. Once logged in, find “Content” in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as “Article
Manager”, “Article Trash”, etc.

3. Choose “Article Manager” from the available options.

4. You should now be presented with a list of all the content articles on your site. There are
a variety of methods to find the specific entry you wish to edit: you can filter by selecting
section, category, author, or even state (published, unpublished, archive). The about
page should be in the section “about” and category “about”. You may also search for
“About” in the filter search box or scroll to the bottom of the page and navigate your way
through the entire list. Once found, click the article title to edit it.
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5. You may then edit the page title, content, etc.

6. Once you feel ready to save your changes, scroll back to the top of the page and click
“Save” (the icon that looks like a floppy disk) in the upper right portion of the page.

Adding an Image

Images are added to articles using the Editor Buttons below the content editor window in the
Edit Article screen. Note: It is possible to insert images using the editor in Joomla! however this
feature provides a simple way of inserting images stored in the images/stories directory of
Joomla!

1. Open the Article for editing either by:
Click the Content > Article Manager menu item to go to the Article Manager,
select the Article and click the Edit toolbar button.
Clicking the Add New Article button in the Control Panel.
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If logged in to the Front-end, you have appropriate permissions and are viewing
the Article you wish to edit: Click the Edit toolbar button.

2. Choose where you would like your image placed in the flow of the text by moving the
cursor and click the Image editor button at the bottom of the screen.

3. The Insert Image screen will open over the top of the Edit Article screen. Choose an
image by clicking on it.

You may also move directory by clicking on the folder icons.
Use the drop down Directory field to quickly select a directory and click the Up
button to go up a directory level.

4. Set the image properties as required:
Image Description: This becomes the alt attribute for the image, an important
feature for accessibility and compliance with web standards.
Image Title: Used for the optional caption and also becomes the title attribute in
HTML.
Align: Sets the image alignment. If left blank the align attribute is not set.
Caption: Enables the caption which displays the Image Title below the image.

5. Click the Insert button to insert the image. The Insert Image screen will close and the
image will be displayed in the editor.

Click the Cancel button to leave the Insert Image screen.

Uploading images using the Insert Image screen

You may also upload new images using the Upload section of the Insert Image screen.

1. Click the Browse button to open a file browser.
2. Select the image files you wish to upload. Click Open in the file browser to confirm the

selection. Note: The file browser style and layout depends on the browser and operating
system you are using.

To remove selected files before uploading click the red icon next to the listed
files.
If you are uploading multiple files in batches you can clear the list of completed
files by clicking the Clear Completed button.

3. The selected file(s) appear as a list at the bottom of the Insert Image screen. Click Start
Upload to begin uploading files.

When the upload is complete a green tick will appear next to the file.
4. You may now select and insert the uploaded image as before.
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Metadata

Overview

Metadata are data about data, for instance a description of a website. Metadata are important
for search engines and are written in HTML. Exactly how important metadata are in the rating by
search engines is debatable. However, metadata represent a good way to describe your
website in short and precise words. 

Note: Google does not use the keywords meta tag in web ranking. See the following article for
details. 

Available Tags

If you check out the HTML source code of a Joomla! site, you will see the following meta tags in
the top area: 

<meta name="generator" content="Joomla! 1.5" />
<meta name="description" content="Joomla! - the dynamic portal engine 
and content management system" />
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<meta name="robots" content="index, follow" />
<meta name="keywords" content="joomla, Joomla" />

Of these, the two attributes description and keywords can be set on an article-by-article basis. 

description
This description of site content is often displayed by search engines. You should pay
special attention to this tag, since the user who has entered a search term often uses
this information to make a decision of whether to visit a site or not. You can add further
information about every individual page to the global description.

keywords
Keywords are very important for a document. You should list the most important
concepts of your website with them. Some search engines index keywords in particular.
The individual words are separated by commas; several words can be entered between
two commas with normal spaces in between. The keywords should be limited to a
maximum of 1000 characters; more than that will not be read by the search engines.
Note that the use of fewer keywords helps each individual word get a higher priority in
the search engine. Deliberate carefully about which are the most often used keywords
and which are likely to be searched for most. You can add more keywords to the global
keywords for every individual page of your website.
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Each article may also specify, in its parameters, whether to include a title or author attribute. 

Show Title Meta Tag
This parameter will insert the following meta tag with the title of the article: 

<meta name="title" content="Welcome to Joomla!" />

Show Author Meta Tag
This parameter will insert the following meta tag with the author of the article: 

<meta name="author" content="Administrator" />
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Archiving

Archiving an Article

Archiving is useful if you publish a lot of articles and which you still want to be published on the
site, but have been displaced in priority by new ones. 

1. Login to the Joomla! Administrator Back-end.
2. Go to "Content" ? "Article Manger" on the toolbar menu.

3. Check the box next to the article you want to archive.  

  

4. Then click "Archive" button.  

  

                         174 / 209



HUB MANAGERS
 

Unarchiving an Article

1. Login to the Joomla! Administrator Back-end.
2. Go to "Content" ? "Article Manger" on the toolbar menu.

3. Check the box next to the article you want to unarchive.  

  

4. Then click "Unarchive" button.  
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The Home Page

Setting a Home Page

The home page is determined by a "default" menu item that has been marked as the default.  

If you wish to change the current home page to a different article, you must add the desired
article to the default menu and mark it as "default". 

Edit

First login to the administrative back-end. 

Once logged in, find “Content” in the main menu bar located toward the top of the page. You
should be presented with a drop-down menu containing items such as “Article Manager”,
“Article Trash”, etc. 

Choose “Article Manager” from the available options. 
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You should now be presented with a list of all the content articles on your site. There are a
variety of methods to find the specific entry you wish to edit: you can filter by selecting section,
category, author, or even state (published, unpublished, archive). The home page should not
be in a section or category (uncategorized). You may also search for the title of your home page
in the filter search box or navigate your way through the entire list. Once found, click the article
title to edit it.

The home page may look a little different than other pages you’ve edited, such as the “About”
page. Some of the content you see on the front page doesn’t appear to be in the page you’re
editing! This is because the home page embeds modules to output some of its content. This is
done with {xhub} tags: 

{xhub:module position="frontLeft"} 

You may assign multiple modules to a position. The {xhub} tag will output all active (published)
modules assigned to the position specified. The style attribute determines if the module(s)
should be wrapped in a containing div or not and is optional. 
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Note: The animated banner and welcome message on the front page are also modules and
managed through Joomla’s “Module Manager” found under the “Extensions” menu item.

Once you feel ready to save your changes, scroll back to the top of the page and click “Save”
(the icon that looks like a floppy disk) in the upper right portion of the page.

Welcome

The “welcome” text, typically found to the right of the Flash banner on the home page is a
module. To edit this module (or any module):

First login to the administrative back-end.

Once logged in, find “Extensions” in the main menu bar located toward the top of the page. You
should be presented with a drop-down menu containing items such as “Module Manager”,
“Plugin Manager”, etc.

Choose “Module Manager” from the available options.
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You should now be presented with a list of all the modules installed on your site. There are a
variety of methods to find the specific module you wish to edit: you can filter by selecting
position, type, or even state (enabled, disabled). The welcome module would be in position
“welcome” and of type “mod_custom”. You may also search for “welcome” in the filter search
box or scroll to the bottom of the page and navigate your way through the entire list. Since
modules are alphabetically sorted by their position by default, “welcome” will most likely be on
the last page of results. Once found, click the module name to edit it.

Once in edit mode you will be presented with some options such as the title, position, etc. To
edit the actual content of the module, scroll down until you see a large text area called “Custom
Output”.
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Edit the HTML/text to be outputted.

Scroll back to the top of the page and click “Save” (the icon that looks like a floppy disk) in the
upper right portion of the page.

Your changes should now be applied and immediately viewable on the front page.
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Content Modifiers

Loading Modules in Articles

Modules may be loaded in an article by including a specific {xhub:module} tag. This tag requires
one attribute: position, which specifies the position that you wish to load. Any modules assigned
to the specified position (set via the administrative Module Manager) declared in the position
attribute will have their output placed in the article in the location of the {xhub:module} tag.  

{xhub:module position="footer"}

Note: To use this feature, the xHUB Tags plugin for content must be installed and active.  

Including CSS or JavaScript

Sometimes we need to load a stylesheet or script for a specific article. HUBzero allows this
through the use of the xHUB content plugin. CSS and JavaScript may be loaded in an article by
including a specific {xhub:include} tag. This tag has a few attributes, each with multiple options: 

type
Required. Determines what sort of file to be included. Accepts "script" or "stylesheet".

filename
Required. The name of the file to be included.

component
Optional. The name of the component the file is to be included from. If not specified, the
file will be included from the template's directory.

<!-- A stylesheet called "home.css" from the current template's /css f
older -->
{xhub:include type="stylesheet" filename="home.css"}

<!-- A script called "resources.js" from the com_resources component -
->
{xhub:include type="script" filename="resources.js" component="com_res
ources"}

Note: To use this feature, the xHUB Tags plugin for content must be installed and active. 
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Outputting Hub Configurations

Sometimes we need to output the value of a specific hub configuration setting. HUBzero allows
this through the use of the xHUB content plugin. HUBzero based configurations (not Joomla!)
may be loaded in an article by including a specific {xhub:getCfg} tag. This tag has one attribute:
the name of whatever configuration variable you wish to output. 

{xhub:getCfg hubShortName}

Note: To use this feature, the xHUB Tags plugin for content must be installed and active.

We also advise extreme caution when using this particular {xhub} tag. 

See Hub Configuration for more information on what configurations are available and how to set
them. 

Getting The Template Directory

Sometimes we need to include content (images, javascript, etc.) from the active template's
directory. HUBzero allows this through the use of the xHUB content plugin. The name of the
active template will be outputted in an article by including the templatedir xhub tag. This tag has
no attributes. 

<img src="{xhub:templatedir}/images/logo.png" alt="Our Logo" />
<!-- outputs: -->
<img src="/templates/mytemplate/images/logo.png" alt="Our Logo" />

Note: To use this feature, the xHUB Tags plugin for content must be installed and active. 
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Deleting

Moving To The Trash

1. Login to the Joomla! Administrator Back-end.
2. Go to "Content" ? "Article Manger" on the toolbar menu.

3. Check the box next to the article you want to trash.  

  

4. Then click "Trash" button. This will move the article to a trash bin so that it can be
retrieved later if needed. It does not permanently delete the article.  
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Permanently Deleting

1. If you want to make sure the Article is completely gone from the system (so no further
roll back is available), go to "Content" ? "Article Trash" on the toolbar menu.

2. Check the box next to the article you want to delete.  

  

3. Then click "Delete" button. This will permanently delete the article. Recovery is not
possible after this action.  
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Note: Articles in the Trash Manager are not the same as Archived Articles. 
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Events

What is an event?

Do you have an upcoming event that you would like to share with other hub users?  The Events
component allows you to submit the details of these events and share them with your
community.

Note: Administrators must first log in to the backend of the hub in order to complete the tasks
below.

Creating an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu.

2. In the Events Manager, select the New icon.
3. Fill in the title of the event.
4. Select the category of the Event.

General: an event is the broadest category for events.
Workshop: is an event that is a clinic for users.
Seminar: is an event that hosts a speaker or presentation.
Meeting: is an event similar to conferences.

5. Add a description in the Activity field that includes details about the event and include
whom the event is intended for.

6. Fill in the location of the event, the website/url that pertains to the event or where event
information is stored, and add tags to connect the event to tag topics.

7. Set the date and time of the event using the drop down calendar from the boxes. An
event can last multiple dates as an expanded time frame. The time span of the event is
calculated in military time.

8. Select the time zone that the event is held in for this helps set up the time frame of the
event for users in different time zones.

9. If the event has registration, fill in the information in the registration section.
Select Register by date.
Enter contact email address. This is the email address to which registration
forms will be sent.
 If registration is restricted for the event (Invite Only), enter a password users
must enter to gain access to the registration form into the Restricted field.
To choose certain registration fields for your event, select the Hide or Show
icons by clicking on the radio buttons in the Registration Fields area.

    10. Click Save to add the event to the Hub calendar. The event will be automatically
published and will appear on the frontend.
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Editing an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu.

2. In the Events Manager, locate the event that needs editing, and click the select the
checkbox next to it.

3. Once the event has been selected, click on Edit icon to edit the content of an event.
4. Fill in the Event details, and then click Save & Close to save the changes.

Deleting an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu.

2. In the Events Manager, locate the event that needs editing, and click the select the
checkbox next to it.

3. Once the event has been selected, click the Delete icon. The event will be permanently
removed from the Hub.

Unpublishing an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu.

2. In the Events Manager, locate the event that needs to be unpublished.
3. In the State column, a green check mark icon indicates the event is currently published.
4. Click the green check mark icon in the state column of the event you’d like to unpublish.
5. The state column will now show a circle with a line through it icon, indicating that it has

been unpublished.

Viewing Event Respondents

If registration was set up for an event, a hub administrator can view the registrant information by
logging into the backend.
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1. On the backend, click the Components tab, and select Events from the drop-down
menu.

2. In the Events Manager, find the event, and select the check box next to it.
3. Once the event has been selected, click on View Respondents button in the upper

right.
4. Now all of the respondents to the Event can be viewed along with information that they

filled out when they registered for the event.

Adding a Page to an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu.

2. On the Events Manager, click the Events tab and select the box of the event you are
editing.

3. Once the event has been selected, click on Add a Page.
4. Add the details of the page for the event. Here extra information can be added to the

event, including details of the event and key information for the participants.
5. Click Save & Close to save the new page to the event.
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Feed Aggregator

What is the feed aggregator?

The Feed Aggregator is a component which allows feed managers to collect articles from
several RSS feeds and to selectively combine them into one site-sponsored RSS feed.

 Users must also be logged into the hub to see any of these controls.

Adding a Feed Manager

In order to access the feed controls, a user must be added as a feed manager.

The feed aggregator controls are only available to those given either the Author, Editor, or
Published role. Users must also be logged into the hub to see any of these controls.

1. Click on Users Menu and select User Manager.
2. Check the box next to the user whom shall be promoted.
3. In the drop-down, select the permission level as Author, Editor, or Publisher, for the

user.
4. Once the group has been selected, click on the Process button to save the changes.
5. The user will now have access to sort posts from the feeds.

Adding a Feed URL (RSS)

1. Navigate to the URL https://yourhubname.org/feedaggregator.
2. Click the Add Feed button in the upper right hand corner of the page.
3. Add the Feed Name, the Feed URL, and enter the description of the feed.
4. Click the Submit button to add the feed to the source feed collection.

Retrieving and Managing Posts

1. Navigate to the URL https://yourhubname.org/feedaggregator.
2. Click the Retrieve New Posts button to pull new posts from the URLs that have been

added to the Feed Aggregator. New posts will be added to the list.
3. Once new posts have been added to the list, manage the new posts by selecting

approve, mark for review, or remove.
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1. Approve - Add the post to the generated feed.
2. Review - Allow other managers to review the post before adding it to the

generated feed.
3. Remove - Remove the post permanently from the collect posts.

4. Once a selection has been made from the three options the choice that was made the
button will turn gray.

5. To change the selection, click one of the other options.

Accessing the Feed URL

1. Navigate to https://yourhubname.org/feedaggregator.
2. To view the feed URL, click on the Generate RSS Feed button.
3. The aggregator link will be generated into a pop-up box with a blue highlighted link.
4. Copy the link into any readers that accept RSS feeds as input.

Disabling a Feed

 

1. Navigate to https://yourhubname.org/feedaggregator.
2. Click the View Feeds button.
3. Locate the feed that is to be disabled.
4. Click the Disable button.  It will then be disabled, and new posts will no longer be

retrieved from the feed and added to the feed aggregator.

Enabling a Feed

1. Navigate to https://yourhubname.org/feedaggregator.
2. Click the View Feeds button.
3. Locate the feed that is to be enabled.
4. Click the Enable button.  Any new posts will be retrieved from the feed and added to the

feed aggregator.

Editing a Feed
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1. Navigate to https://yourhubname.org/feedaggregator.
2. Click the View Feeds button.
3. Locate the feed to be edited, and click the feed’s Edit button.
4. Edit the content of the feed, and then click Submit.
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Forum

What is a Forum?

A forum, or message board, is an online discussion area where people can hold conversations
in the form of posted messages.

Forums have a specific set of jargon associated with them; e.g. a single conversation is called a
"thread" or discussion.

A discussion forum is hierarchical or tree-like in structure: a forum can contain a number of
sections, each of which may have several categories. Within a forum's category, each new
discussion started is called a thread, and can be replied to by as many people as so wish.

 

What is a section?

Sections are a way to organize or group related categories (topics). By default, sections are
sequenced alphabetically by title.

 

What is a category?

Forum categories are a simple way to group related threads or discussions together. When a
category is locked, no new threads may be created within that category. Typically, a locked
category will be indicated as such by a padloack icon.

 

What is a thread?

A thread (sometimes called a discussion) is a collection of posts displayed from oldest to latest.
A thread is defined by a title, an additional description that may summarize the intended
discussion, and an opening or original post (common abbreviation OP, which can also mean
original poster), which opens whatever dialogue or makes whatever announcement the poster
wished. A thread can contain any number of posts, including multiple posts from the same
members, even if they are one after the other.

Note: Users must be logged in to the hub in order to participate in the forum.
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Creating a Category

1. Navigate to the Component tab and click on Forum.
2. On the Forum component, select the Category tab and then click on the New button on

the top of the page.
3. Fill in the title of the new category.
4. Fill in the alias or title that will be displayed in the URL.
5. Fill in the scope or site and the scope ID or site identification number for the new

category.
6. Select the state of publish from the drop-down.

a. Unpublished: The category will be removed from the frontend Hub but available
on the backend of the Hub.

b. Published: The category will be available of the frontend and backend of the
Hub.

c. Trashed: The category will be removed from the Hub.
7. Select the access level from the drop-down.

a. Public: All visitors or users of the Hub can access the category.
b. Registered: Only registered users of the Hub can access the category.
c. Special: Only registered users with special permissions can access the

category.
d. Protected: Only users with protected rights can access the category.
e. Private: No users besides the creator of the category can access the category.

8. The Category can be locked so that no new posts will be allowed by checking the box in
Details.

9. Click Save & Close to save the new section and to return to the Forum dashboard.

Creating a Section

1. Navigate to the Component tab and click on Forum.
2. On the Forum component, select the Section tab and then click on the New button on

the top of the page.
3. Fill in the title, alias (URL ending), scope (site), and scope ID for the new section.
4. Select the state of publish (unpublished, published, or trashed) from the drop down and

the access level (public, registered, special, protected, or private).
5. Click Save to remain on the Forum: New Section edit page or click the Save &

Close to save the new section and to return to the Forum dashboard.
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Creating a Discussion Thread

1. Navigate to the Component tab and click on Forum.
2. In the Forum component, select Threads.
3. Click the New icon.
4. Fill in the title, alias (URL ending), scope (site), and scope ID for the new section.
5. Select the state of publish (unpublished, published, or trashed) from the drop down and

the access level (public, registered, special, protected, or private).
6. Click Save to create the thread.

Deleting a Discussion Post

1. Navigate to the Component tab and click on Forum.
2. In the Forum component, find and select the Forum thread post to be edited by clicking

the Delete icon.
3. The forum post will be automatically deleted and saved. Once a post is deleted, the

material cannot be retrieved.

Limiting Thread Viewing Access

(Note: You have to be logged into your hub in order to complete the following tasks)

 

1. Click the Components tab and then select the Forum button located in the drop-down.
2. On the Forum page, click the Threads tab.
3. Select the title of the thread and then click the discussion post’s title.
4. Under the Publishing Options, selecting from the drop-down can change the 

Access of the discussion thread. 
a. Public: All users or visitors to the Hub can view the discussion thread
b. Registered: Only logged in users can view the discussion thread
c. Private: Only certain members have access to the discussion thread

5. Save these changes by clicking the Save & Close button.
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Knowledge Base

What is the knowledge base?

The knowledge base houses helpful articles and frequently asked questions. Hub managers
can add their own hub specific articles to help their community understand how to use the
features.

 

Creating Knowledge Base Articles

1. Navigate to the Knowledge Base under the Component tab.
2. Select the tab Articles.
3. Select New to create a new article.
4. Select the category or sub category where the article will be located.
5. Fill in the title, URL alias, the body containing the article, and tags to connect the article

for easy search.
6. Under State, select if the article is to be published to the Hub and the access level from

the dropdown.
7. Select the parameters on what sections of the article that the users can view.
8. Select the Save & Close to save the new article.
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Projects

Enabling Plug-in to Projects

1. Login to the backend of the Hub and click on the Extensions tab.
2. Click on the Plug-in Manager under the Extensions tab.
3. Search Projects- Databases in the search field to locate the Data Store plug-in.
4. After locating the correct plug-in, check the box beside the Plug-in Name.
5. Click the Enabled button to allow the plug-in to be used on the frontend of the Hub.

Restricting Plug-in to Specific Projects

1. Login to the backend of the Hub and click on the Extensions tab.
2. Click on the Plug-in Manager under the Extensions tab.
3. Search Projects- Databases in the search field to locate the Data Store plug-in.
4. After locating the correct plug-in, click on the title of the plug-in under the Plug-in

Name column.
5. Inside the plug-in details, type in the names of the Projects in the Restricted to

projects field.
6. Save the changes by click the Save & Close button.
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Publications

Curation Workflow

Turning on Curation:

1. From the backend, navigate to Components -> Publications.
2. Click the Options button.

3. Click the Curation tab.
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4. Select ON in the Curation field.
5. In the Name of Group of curators field, type in the CN of the group you want to give

curation rights to. 
6. Optionally, select 1 month in the Grace period for changes box if needing to give users

the ability to change the publication after it has been published.
7. Click Save & Close to ensure the changes and are submitted.
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Spam

How to Remove Spam Accounts from Hubs

Detecting spam on Hubs can be found in Resources, Blogs, Events, Wiki Pages, Groups, Tags,
and Wish lists. Once the spam has been located, check the creator of the spam to disable their
accounts so they can no longer spam the Hub. Once you have disabled the account, delete the
spam content that was found before.

Things to Look for

Unprofessional profile pictures
Non-Hub related information in the Bio
Unprofessional URLs/links to outside websites
Inappropriate language
Selling ads or promotional information
Non-Hub related content
Components on the Hub with links in the text box

Steps for Removing Spam

1. Find the Spam
2. Figure out the creator
3. Disable the creator
4. Delete the Spam content

Disable Accounts for Spam

1. Find the account that created the Spam, and then on the backend of the Hub navigate to
Users and then click on Members. Click on the name to open up account details.

a. Note: You can usually be sure that the account is a spammer if they have a Hub
nonrelated website link in the URL and an unprofessional profile picture.

2. If the Public Profile box is checked, uncheck it. It is important to make the profile not
available to the public incase they have Spam links in their account.

3. Uncheck the Confirmed box if the user had confirmed their account. If it is not checked
leave it unchecked.

4. Change the Contact me drop-down to the No, Don’t send me emails option.
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5. Change the spam account password by typing into the New Password field a long and
random password that the spammer could not figure out.

6. Click Save & Close. 
7. Find the spam account in Users > User Manager.
8. Check the box beside the user’s name and then click Block to block the user from the

Hub.
9. After disabling the spammer’s account, find the spam that the individual has put on the

Hub and delete it.
a. Make sure that they account has been deactivated prior to deleting the Spam.

This way the spammers will not receive emails about their content being deleted.
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Super Groups

Creating a Super Group

 

1. Log in to the backend of the Hub and hover over the Users tab and select Groups.
2. Click New to create a group.
3. Select the group type from the drop-down to be Super.
4. Fill in the CN or group alias, the title and logo of the group, along with the public and

private group descriptions.
5. In Membership Control, check the box if the membership is to be controlled. The

membership Join Policy determines access level for the group.
a. Public: Any user on the Hub can join the group.
b. Restricted: Qualifications are given that predetermines who can join. These

restrictions have to be added into the credentials. 
c. Invite Only: A group manager has to send an invite any new group members to

the group.
d. Closed: No one can join the group unless they are added from the back-end of

the Hub.
6. Determine the access level of the group from hidden or visible. A hidden group is not

listed on the front-end of the Hub, and any content is unavailable to any user that is not
a member of the group. A visible group can be found on the Hub through regular
searches.

7. Once all the group’s content has been filled in, then save the new group by
clicking Save & Close. The group will be automatically approved and visible on the Hub.

8. The following will be automatically created when making the super group:
a. Base template with custom error handling & login
b. Separate database for super group related components, data, etc
c. If Gitlab integration is enabled, all needed connections will be made and super

group folder will be controlled via Git.

 

Frontend Module Management in Super Groups

 

Accessing the Module Manager:

1. Log in to the Hub and access the Super Group home page.
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager.
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3. Select the Manage Modules tab to view the module manager.
4. Search for modules by using the search drop-down that searches for a module based on

location and title.

 

Adding a Module:

1. Log in to the Hub and access the Super Group home page.
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager.
3. Select the Manage Modules tab to view the module manager.
4. Click the New Module button in the toolbar
5. Fill in all required fields and click Save Page.

 

Publishing a Module:

1. Log in to the Hub and access the Super Group home page.
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager.
3. Select the Manage Modules tab to view the module manager.
4. Publish the module by clicking on the Unpublished icon. The icon will become a 

Published icon.
5. The module will now be available on the front interface of the Hub.

 

 Unpublishing a Module:

1. Log in to the Hub and access the Super Group home page.
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager.
3. Select the Manage Modules tab to view the module manager.
4. Unpublish the module by clicking on the Published icon. The icon will become an 

Unpublished icon.
5. The module will now be removed from the front interface of the Hub.

 

Editing a Module:

1. Log in to the Hub and access the Super Group home page.
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page manager.
3. Select the Manage Modules tab to view the module manager.
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4. Click on either the Manage Module button or hover over the arrow next to the button to see more
options, including Edit Module.

5. One of the new features with the module manager is the page content WYSIWYG editor. It now uses
CKEditor and HTML to manage your page content.

6. Modify the module with new changes, and then click the Save Page.

 

Reordering a Module:

1. Log in to the Hub and access the Super Group home page.
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager.
3. Select the Manage Modules tab to view the module manager.
4. Click on either the Manage Module button or hover over the arrow next to the button to

see more options, including Edit Module.
5. One of the new features with the module manager is the page content WYSIWYG

editor. It now uses CKEditor and HTML to manage your page content.
6. Modify the ordering of the module by using the drop-down, and then click the Save

Page.
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Support

Tickets

Users can create tickets when they experience a problem on the Hub that is not answered in
Questions and Answers or Knowledge Base. Tickets are ways to report bugs or issues that they
experienced with the Hub. Administrators are then able to access the Support component to
help solve these issues.

 

Answering Tickets

1. Navigate to https://yourhub.org/support and login to the hub.
2. Access the Support and Ticket Tracking System.
3. Select the tickets that are under the open tab on the side of the page.
4. Select the ticket that has been unanswered.
5. In the Comment Form, add tags to connect the ticket to search engines in the ticket

system.
6. In the assignee dropdown select your name. Note: You can only be an assignee if you

have gained ACL access on the back-end of the Hub.
7. Select the severity of the ticket. Critical and major are high priority tickets. Normal tickets

are common yet important tickets. Minor and Trivial tickets are low priority.
8. Select the status of the ticket from the drop down. Open tickets are unanswered tickets; 

Awaiting User Action holds the ticket until they answer or respond. Closed tickets are
listed by the reason they are closed: Answered, Duplicate, Fixed, Invalid, Spam,
Transferred, Won’t fix, and Works for me.

9. Answer or leave a canned response for the user that submitted the ticket. Canned
responses allow the assignee to respond using generic responses premade to fit various
situation such as: first response, second response, and closing ticket.

10. In the bottom box CC any users or other assignees to the ticket to include in the
conversation on the ticket, then submit your response.

 

Messages

To aid in responding to support ticket submissions, you may create custom message templates
for frequently used responses. Example responses include a “Ticket resolved” message sent
upon closing a ticket or a “Request for more information” message.

Messages may also include placeholders where information that changes can be specified. For
instance your message template may include references to the specific ticket ID number or site
name. A “Ticket resolved” template could look like this:
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“Thank you for using the (sitename), and for reporting this problem. We believe that your issue
(ticket#{ticket #} in our system) has been resolved. If you continue to have problems please let
us know.  You may reopen a closed issue at any time by following the link at the end of this
message and adding a comment to the ticket.

Thank you for helping us to improve (sitename)!

--the (sitename) team

Here we have two placeholders: {ticket#} and {sitename}. The placeholders are replaced with
their current value at the time of composition. When chosen from the select box under
“Comments” of the response form, the comments text box will be filled with the following:

“Thank you for using the YourHUB, and for reporting this problem. We believe that your issue
(ticket #123 in our system) has been resolved. If you continue to have problems please let us
know. You may reopen a closed issue at any time by following the link at the end of this
message and adding a comment to the ticket.

Thank you for helping us to improve YourHUB!

--the YourHUB team

 

Resolutions

Resolutions give a report of how the ticket was solved once it is closed. For example if a ticket
was answered the resolution would be “Answered” or if the ticket was never answered because
the ticket owner did not respond with new information then the ticket could be closed with the
resolution “Closed (No Answer).” This system helps inform the support team or administrators
that search through closed tickets the necessary information on why the ticket was closed.

Open- unanswered ticket
Awaiting user action- waiting for user to respond
Closed- ticket has been answered or fixed
Answered- answered question of the user
Duplicate- the issue has already been reported
Fixed- the bug that was reported has been fixed
Invalid- this status is used for testing purposes and spam
Transferred- the issue was a enhancement request and moved to the wish list
Won’t fix- no solution to the issue
Works for me- the bug reported is not reoccurring for assignee of the ticket

 

Tags

                         207 / 209



HUB MANAGERS
 

The tags allow tickets to be searched and tracked easily. Tags can also serve to inform the
support team about the problem without reading through the whole context of the ticket.

 

Stats

The stats page gives a basic overview of support ticket activity starting at the beginning of a
chosen year, defaulting to the current year if none is specified. Stats shown may also be filtered by

group.

The following data is shown:

Tickets opened for the given year
Tickets closed for the given year
Tickets opened for the current month of the year
Tickets closed for the current month of the year
Tickets opened for the current week of the year
Tickets closed for the current week of the year
Open tickets
Unassigned tickets
Average ticket lifetime
A list of administrators and the number of tickets closed

Closed for the given year
Closed for the current month of the year
Closed for the current week of the year

A line chart displaying Tickets Submitted (red) vs. Closed (green) on a monthly basis

Support: Access Control Layer (ACL)

The ACL (Access Control Layer) works in conjunction with a user login system to allow or deny
a user access to support tickets and various information or features of a ticket.

Permissions may be set for individuals or entire groups of users. All members of a group will
inherit any permission set for the group. If a user is a member of multiple groups with ACL
settings, the highest permissions will take affect.

Individual ACL settings take precedence over any other settings.

 

ACL Options 
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1. Navigate to https://yourhub.org/administrator and log into the backend of the Hub.
2. Click on the Components tab and then select the Support button from the drop-down.
3. Inside of Support, click on Options to view details in the ticket submission process.
4. There are three tabs that all define the parameters of tickets and available options for

the Hub ticket system.
a. Defaults: displays the front page options when submitting and answering tickets
b. Files: controls the parameters of how documents and tickets are uploaded
c. Antispam: controls the words that can be used when submitting tickets to keep

spam out of the ticketing system
5. Click Save or Save & Close to allow the changes that were made in these tabs to be

saved on the Hub.

 

Giving ACL Permission 

1. Navigate to https://yourhub.org/administrator and log into the backend of the Hub.
2. Click on the Components tab and then select the Support button from the drop-down.
3. Inside of Support, click on the ACL tab.  
4. Under all of the available users that have permission for ACL access, there is a text box

to input alias or ID name.
5. Input the name of the new ACL access, then select the sections that the user can have

control in.
6. Click Add to confirm the new ACL access for the user. 

Note: Super Administrators automatically receive ACL access and support
permissions.

Enabling Email Notification for Abuse Reports

1. Navigate to https: yourhub.org/administrator, and login as an administrative user on
the backend of the Hub.

2. Click the Components tab and then select the Support button located in the drop-
down.

3. On the Support: Tickets page, select the Options button in the top-right corner of the
page.

4. Select the Abuse Reports tab.
5. Enable notifications to be sent when a report is created by selecting Yes from the drop-

down.
6. Add the email address that the notification should be sent to by inserting it into the

“Notify when abuse report created” box.
7. Click the Save & Close button to save the changes and you will be navigated back to

the Support: Tickets page.
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